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European Notice

Products with the CE marking comply with both the Electromagnetic Compatibility
Directive (89/336/EEC) and the Low Voltage Directive (73/23/EEC) — as amended by
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Modifications to the Product

CE Markin
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Battery Replacement
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that you call your local dealer. The battery is not user replaceable.

WARNING This unit contains a non-replacesble interna Lithium lon battery. To reduce the
risk of fire or burns, do not disassemble, crush, puncture, or dispose of in fire or water.

Contact your local waste management officials for other information regarding the
environmentally sound collection, recycling, and disposal of used batteries.

AC Adapter

Use only the AC adapter supplied with your Pocket PC. Use of another type of AC
adapter will result in malfunction and/or danger.

This product is intended to be supplied by a Listed Power Unit marked “LPS” and output
rated +5 V dc / 900mA minimum.



Preface

This reference guide contains detailed information on the use of the NEC
Pocket PC powered with the Microsoft® Windows® Powered Pocket PC 2003.

The guideis organised as follows:

Chapter 1 — Get Started, provides procedures for unpacking, charging
the battery, calibrating and installing Microsoft ActiveSync®.

Chapter 2 — Learn the Basics, includes information on using pop-up
menus, notifications, entering information and customising your Pocket PC.

Chapter 3 — Use Microsoft Pocket Outlook, provides procedures for using
Microsoft Pocket Outlook Calendar, Contacts, Tasks, Notes and Inbox.

Chapter 4 — Use the Companion Programs, includes information on
using Pocket Word, Pocket Excel, MSN Messenger, Windows Media™
Player for Pocket PC, Microsoft Reader and Pictures.

Chapter 5 — Use Pocket Internet Explorer, provides information and
procedures for using Pocket Internet Explorer, Mobile Favourites folder
and AvantGo interactive service.

Chapter 6 — Get Connected, includes procedures for connecting to the
Internet and private network and for transferring data using infrared.

Chapter 7 — If You Have Problems, includes information on solving
problems that you might have in using the Pocket PC.

Chapter 8 — Specifications includes specifications for the Pocket PC and
its accessories.
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Unpack Your Pocket PC

Y our Pocket PC ships with a number of accessories. When you unpack the
Pocket PC, verify that you have al of the items listed here and that they are
in good condition. If anything is missing or damaged, contact the dealer
that sold you the Pocket PC.

Note Before you use your Pocket PC for the first time, you need to set
the hard reset switch and charge the battery (see “Charge the Battery” later
in this chapter).

m  Pocket PC (includes a stylusin a storage compartment)
m  Pocket PC AC Adapter with European or UK Converter
m  Pocket PC Universal Serial Bus (USB) Cradle

m  Companion CD (contains the Microsoft ActiveSync software and your
documentation)

m  Pocket PC Getting Started Guide

m Pocket PC Reference Guide (this document, included on the
Companion CD)

m  Pocket PC Release Notes (optional)
m  Service & Warranty booklet

Get to Know Your Pocket PC

Your Pocket PC is a multifunction handheld device designed for ease of
use in the office, on the road, at home or wherever you are.

The Pocket PC is powered by the Microsoft® Windows® Powered Pocket
PC 2003 operating system. Data synchronising between the Pocket PC and
acomputer is provided by Microsoft ActiveSync®.

Standard features include a 300-MHz Intel® PXA255 processor, 64-MB
synchronous dynamic random access memory (SDRAM), reflective LCD
panel with 65K colour, touch screen with automatic backlighting, internal
speaker, microphone and a rechargeable Lithium lon battery. Touch screen
backlighting levels are adjustable.

The Pocket PC includes an infrared (IR) port and Secure Digita
(SD)/MultiMediaCard (MMC) card dot. You can use the IR port to
transfer data between other handheld devices with IR capabilities or your
computer. The SD/MMC card dot can be used to expand memory, add
applications and more.

Also included with the Pocket PC is a cradle for holding the Pocket PC.
Use the cradle to synchronise with your computer.

Y our Pocket PC comes with a stylus, a pen-like device that alows you to
touch, tap or double tap objects on the Pocket PC touch screen. The touch,
tap and double tap act just like a point, click and double click of a mouse.

The externa features of the Pocket PC and USB cradle are shown and
described in the following sections.
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Front Features m  Touch Screen — enter, read, send, receive and modify data by tapping
the touch screen with the stylus. Backlighting is automatic with

The front features of the Pocket PC are shown in the following figure. automatic dimming after a preset time. Tap the touch screen to restore
Brief descriptions follow the figure. full lighting.
m  Program Buttons — press or tap the Notes, Calendar, Contacts or
Pocket PC Front Features Tasks button for quick access to tasks or programs. The buttons are
customisable.

m  Microphone — records your notes.
L4|I| = Navigation Buttons — use the four buttons as arrow keys, the same as
you would for a keyboard' s up, down, left and right arrow keys.

m  Speaker — sounds alarms and plays back sound recordings.

m  Battery Charging LED — lights amber while the battery is charging.
@ The light goes off when the battery is charged.

m  Notification LED — blinks red to indicate an alarm or reminder.

A — Touch Screen F — Calendar Button

B — Notes Button G — Speaker

C — Microphone H — Tasks Button

D — Contacts Button | — Battery Charging LED
E — Navigation Button (4) J — Notification LED
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Back Features Right Side Features

The back features of the Pocket PC are shown in the following figure. The right side features of the Pocket PC are shown in the following figure.
Brief descriptions follow the figure. Brief descriptions follow the figure.
Pocket PC Back Features Pocket PC Right Side Features

C
C C ‘__@

=

A — Hard Reset Switch
A — Headset Jack

A CAUT'ON Always leave the switch in the ON (down) position

unless you need to perform a hard reset. A hard reset will cause the

memory of your Pocket PC to be cleared. m  Headset Jack — Use this standard 3.5 mm port to connect an optional

headset.

m  Hard Reset Switch — restores your Pocket PC to factory settings (see
“Hard Reset” in Chapter 7).
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Left Side Features Top Features

The left side features of the Pocket PC are shown in the following figure. The top features are shown in the following figure. Brief descriptions
Brief descriptions follow the figure. follow the figure.
Pocket PC Left Side Features Pocket PC Top Features

Li[

(o]

@ A — IR Port C — Power Button
B — SD/MMC Card Slot D — Stylus

13s3y

m |R Port — exchange data with another handheld or your computer
(both must have IR capabilities).

m  Secure Digital (SD)/MultiMediaCard (MMC) Card Slot — holds an
SD or MMC card. Insert an optional SD/MMC card in this slot to add
memory to your Pocket PC or expand the capabilities of your Pocket
PC.

m  Power Button — turns power on and off. Turn the backlight off by
A — Scroll Dial C — Reset Button pressing and holding.

B — Recording Button . . .
m  Stylus — use to tap or write on the screen. Slide the stylus out of its

storage compartment on your Pocket PC.
m  Scroll Dial — useto scroll through a menu and to select a program.

m  Recording Button — records sound in a program where you can
include arecording (see “Record aMessage’ in Chapter 2).

ACAUT'ON Always use the stylus for tapping the touch

m  Reset Button — performs a soft reset of the operating system in case screen. Never use hard-pointed or sharp objects. These objects can
of malfunction (see “Soft Reset” in Chapter 7). Your datais preserved damage the touch screen.
if it was saved.
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Bottom Features Cradle Features

The bottom features are shown in the following figure. Brief descriptions Use the cradle to hold the Pocket PC when charging the battery,
follow the figure. synchronising data with your computer or when you keep your Pocket PC
on for long periods.

Pocket PC Bottom Featur
ocket PC Botto eatures The cradle features are shown in the following figure. Brief descriptions

follow the figure.

I—T—' Pocket PC Cradle Features

_‘ —@ A — USB Connector
- " B — Power Connector
-—.- E] C — Pocket PC Connector

A — Cradle Connector B — Power Connector

m  Cradle Connector — connect the USB cradle to this connector. Use
the cradle to synchronise the Pocket PC with your computer.

m  Power Connector — connect the AC adapter to this connector. .

m  USB Connector — connect to the USB port on your computer for
synchronising data.

m  Power Connector — connect the AC adapter to this connector.

m Pocket PC Connector — connect your Pocket PC to this connector.
Use the cradle to charge the battery and to synchronise the Pocket PC
with your computer.
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Before You Start
The hard reset switch on the back of your Pocket PC should be switched to

the ON (down) position before you can use your Pocket PC. If thisis not
the case, please set it to the ON position.

1. Make surethat your Pocket PC is switched off.

2. Unscrew the cap of your stylus. Use the pointed end of the cap to slide
the hard reset switch to the ON (down) position.

+

! (

A CAUTION Always leave the switch in the ON position unless

you need to perform a hard reset. A hard reset will cause the memory of
your Pocket PC to be cleared.

Charge the Battery

Your Pocket PC contains a rechargeable Lithium lon battery. The battery
must be charged before you use the Pocket PC the first time. You can
periodically recharge thereafter.

Battery power is monitored by your Pocket PC. Warning messages and
battery low icons are displayed when battery power becomes low. If you
receive a “battery low” warning message, you should save your data and
recharge the battery as soon as possible to avoid data loss.

You can also monitor battery power activity through the “power
remaining” indicator on your Pocket PC. Tap Start, Settings, the System
tab and Power to see the indicator.

Note Before using your Pocket PC for the first time, you need to charge
and calibrate the battery.

Charge the battery as follows:

1. You may need to connect the appropriate converter to the AC
adapter’s plug according to your country.

2. Connect your Pocket PC to an AC power source.

m If you are using the cradle for charging, install the Pocket PC in
the cradle, plug the appropriate end of the AC adapter into the
power connector on the USB cable and plug the other end into a
grounded AC outlet.

= If you are not using the cradle, plug the appropriate end of the AC
adapter directly into the power connector on the bottom of the
Pocket PC and plug the other end into a grounded AC outlet.
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Charging the Battery

,—@ -.-.-._)

A — Battery Charging LED D — Power Connector
B — Pocket PC E — AC Adapter
C — Cradle

3. Wait till the battery is fully charged. This may require a couple of
hours.

m  The battery-charging LED lights amber, indicating that the battery
is charging.

= You can also check the “power remaining” indicator.

4. When the battery is fully charged, the following occurs.
m  The battery-charging LED is off.
= The“power remaining” indicator indicates 100%.

5. You can leave the Pocket PC in the cradle and the AC adapter
connected to keep your battery charged.

Note Whenever possible, keep your Pocket PC connected to the AC
adapter and a power source. This keeps the battery charged.

Note If you want to unplug the AC adapter after the battery has been
fully charged, wait at least 5 seconds. This length of time is necessary for
the battery calibration to complete and thus ensure the best performance of
the battery. Should your Pocket PC indicate a low battery level just after it
has been fully charged, please repeat the battery calibration procedure.

Now calibrate and activate your Pocket PC (see “Cadlibrate and Activate
the Pocket PC” in the following section). Calibration must be done to
ensure proper operation of your Pocket PC.
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Calibrate and Activate the Pocket PC

It is essential that you calibrate and activate your Pocket PC before you use
it. This ensures accurate positioning when entering text and selecting
menus. Calibrate and activate the Pocket PC as follows.
1. Pressthe power button to switch on the Pocket PC.

2. Tap the touch screen with the stylus to start the calibration and
activation.

3. When prompted to align the screen, tap the centre of the cross
wherever the travelling cross stops on the screen. You might have to
do this several timesto properly calibrate.

4. On completion of the screen calibration, follow the screen prompts to
complete the activation.

= Inthe“Stylus’ screen, tap Next to continue.
= Inthe“pop-up menus’ screens, perform the indicated operations.
= Inthe“Congratulations’ screen, tap next to continue.

= In the “location” screen, select your time zone and tap Next to
continue.

= Inthe“completion” screen, tap the screen to continue.

m  The“Today” screen displays.
Your Pocket PC is now ready to use. The following sections describe the
Pocket PC's two basic screens and how to use them for performing

functions. Also included is information for installing ActiveSync on your
compulter.

Learn the Basics

There are two basic screens you need to know about to get started. These
arethe “Today” screen and the “Navigation Bar” screen.

The first screen that you normally see on startup is the “Today” screen.
This screen displays your important events (for example, current date and
time, your name, upcoming appointments, unread messages, tasks).

Tapping & or tapping Start on the “Today” screen with the stylus takes
you to the “Navigation Bar” screen. In the Navigation Bar, you can select
and access the programs available on your Pocket PC. Tap Start to go back
to the “Today” screen.

Your actions in these basic screens are controlled with the stylus. The
stylusis used asfollows.

m  Tap — touch the screen once with the stylus to open programs and
select options.

m  Drag — hold the stylus on the screen and drag across the screen to
select text and images. Drag in alist to select multiple items.

m  Tap and Hold — tap and hold the stylus on an item to see a list of
actions available for that item. In the displayed pop-up menu, tap the
action that you want to perform.

For more information on using the “Today” screen, Navigation Bar and
stylus, please refer to the following sections.
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Today Screen

The “Today” screen normally appears whenever you power on the Pocket
PC. On the “Today” screen, you can see at a glance your important
information for the day. The following figure shows a typical “Today”
screen and what you can do from it.

Typical Today Screen
Tap to view network status and options.
Tapto goto Tap to change volume or mute all zounds.
& prograrm. Tap and hold to change time format.

Thursday, January 23, 2003 F Tap to change date and time.
Owner: Adam Barr
(206) 555-1212 I Tap to change owner information.

Kim's hirthday

Your day at a glance. Tapto
open the aszociated program.

_ Tapto dizconnect from
ActiveSync,

|— Tap to create a new item.

At the top of the screen isthe “Start” bar. The bar displays the current time
and any active program. The bar also allows you to switch to programs and
close screens.

From the “Today” screen, you can select any of the listed activities by
tapping on your selection with the stylus. For example, if you just activated
your Pocket PC, you might want to enter your name as the owner. Do this
asfollows.

1. Inthe“Today” screen, tap Tap here to set owner information.

2. Inthe “Owner Information” screen, tap the triangle at the lower right
corner of the screen.

3. Inthe“Options’ screen, tap Keyboard. A soft keyboard displays.

4. Tap once in the “Name” field. A blinking cursor appears, indicating
that you can enter data.

5. Use the keyboard to tap in your name, just as you would with your
computer keyboard.

o

If you make a mistake and need to remove a letter(s) or remove a
word(s), you can:

m correct minor mistakes by placing the cursor after the letter or
letters to be deleted and pressing the backspace arrow on the
keyboard to delete the letter or letters.

m  highlight a whole word(s) with the stylus and pressing and
holding the stylus on the word(s). A pop-up menu gives options to
Undo, Cut, Copy, Paste, Clear or Select All.

7. When done, click on B9, vour changes are saved and the “Today”
screen displays with your name as the owner.

At the bottom of the “Today” screen is the Command Bar. Tapping New
on the bar lists severa tasks that you can tap to open. Use this as a short
cut to open any of the listed tasks.
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By using the stylus and severa control buttons, you can open tasks from
the “Today” screen and Navigation Bar and enter or read data at selected
screens.

Navigation Bar Screen

3

4 or tap Start at the top of
the “Today” screen. The Navigation Bar displaysin the “Today” screen.

e

To switch to the “Navigation Bar” screen, tap

From the Navigation Bar, you can select any one of the listed activities by
tapping on your selection with the stylus. You can aso use the navigation
buttons on the front or the scroll dial on the side of the Pocket PC to scroll
up or down, then open the highlighted program by pressing the dial.

Typical Navigation Bar Screen

4 4% 6:38

— Tapto switch to a program
___ that you recently used.

@l ActiveSync
[=] Calendar
[=] Contacts s
| Inbox | Taptozwitchtoa
oz [ oA,

——Tap to zee mare programs.
| — Tap to change device
settings.

— Tapto see a Help topic for
the current screen.

The “Start” bar at the top of the screen displays the time and one or more
status icons. The bar also displays the &4 icon which you can tap to return
to the “Today” screen. A Command Bar appears at the bottom of the
screen. Tap New in the bar to return to the “Today” screen.

To select a program from the Navigation Bar (for example, Contacts), tap
or tap Contacts. Y ou can aso tap the Contacts button on the front of

the Pocket PC. Please note the Contacts command bar at the bottom of the
screen.

The Contacts command bar has a New button for creating a new contact, a
View button for selecting the type of contact, a Tools button for
performing various tasks and an input panel button. Tapping the input
panel button displays a soft keyboard which you can use to create or edit a
contact.

Tap to select & type of cortact Tap to set options
O
T
New ¥Yiew Tools El*

]
|Tap to create a newy contact

You can aso input information by writing data on the screen. Tap the
triangle in the lower right corner of the screen and tap Block Recognizer,
Letter Recognizer or Transcriber. For information on using each input
device, tap 7] Help to open a help screen.

Close the open activity window by tapping Blin the upper right corner of
the screen. If you revised or added anything, tap kK to save any changes.

Many of the programs available on your Pocket PC are selected and used
in amanner similar to that described for Contacts.
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The following table lists the activities on your Navigation Bar. To seethe list
on your Pocket PC, tap Start to open the “Navigation Bar” screen. Tap
Programs to see more activities. Look on the Companion CD for additional
programs that you might want to install.

Activities
Icon Program Description

Synchronise information between your Pocket

@ ActiveSync PC and computer.

E Calendar Keep_ track of your appointments and create
meeting requests.
5 Contacts  Keep track of your colleagues and friends.
@ Inbox Send and receive e-mail messages.
| View Web pages downloaded from your
nternet
ﬁ E computer or connect to the Internet to browse the
xplorer
Web.
Notes Create_ hand-written or typed notes, drawings and
recordings.
Tasks Keep track of your tasks.
Windows . . )
) Media  Pay audio or video files.
[% Tap Programs to see a list of the various
Programs )
programs available to you.
. Tap Settings to see the various areas that you
@ Settings . o .
can access for changing/reviewing settings.
E’ Find Tap Find to find data in your Pocket PC.
e Help Tap Help to see the Help Contents.

For further information on accessing and using the activities, tape Help on
the Navigation Bar.

Install ActiveSync

A key component of your Pocket PC is the Microsoft ActiveSync program.
With Microsoft ActiveSync, you can synchronise the information on your
computer and/or a Microsoft Exchange Server with the information on
your Pocket PC and update both with the most recent information.

Note You can synchronise information directly with a Microsoft
Exchange Server if your company is running Microsoft Mobile Information
Server 2002 or later.

For example;

m  Keep Microsoft Pocket Outlook® data up-to-date by synchronising
your Pocket PC with Microsoft Outlook data on your computer.

m  Synchronise Microsoft Word and Microsoft Excel files between your
Pocket PC and computer. Your files are automatically converted to the
correct format.

Note By default, ActiveSync does not automatically synchronise all
types of information. Use ActiveSync options to turn synchronisation on and
off for specific information types.

With ActiveSync, you can also:
m  Back up and restore your Pocket PC data.

m  Copy (rather than synchronise) files between your Pocket PC and
compulter.

m  Control when synchronisation occurs by selecting a synchronisation
mode. For example, you can synchronise continually while connected
to your computer or only when you choose the synchronise command.

m  Select which information types are synchronised and control how
much data is synchronised. For example, you can choose how many
weeks of past appointments you want synchronised.
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Your Pocket PC comes with ActiveSync already installed. However, to
synchronise information with your computer, you must aso install
ActiveSync on your computer.

Install ActiveSync on your computer from the Companion CD as follows:

Note Before starting the ActiveSync installation, ensure that you have
Microsoft Outlook 2002 or later installed on your computer. If you do not
have Outlook, you can install Outlook 2002 from the Companion CD.

Note Do not connect your Pocket PC to the computer until ActiveSync
is installed.

1. Power on your computer.

2. |nsert the Companion CD into the CD-ROM drive of your computer.
The CD starts automatically and displays the “Getting Started with
Y our Pocket PC" screen.

3. Inthe “Getting Started with Your Pocket PC" screen, click on Start
Here.

4. If you have not installed Outlook, install it now. Click on Install
Outlook 2002 in the “Start Here” screen and follow the prompts.
Return to the “ Start Here” menu when done.

5. Inthe“Start Here” screen, click on Install ActiveSync 3.7.
6. Inthe“Install ActiveSync 3.7” screen, click on Install.

7. In the “File Download” screen, click on Open if your operating
system is Windows XP or click Run this program from its current
location if your operating system is Windows 2000/M &/98.

8. Follow the prompts to install ActiveSync on your computer. When
prompted, connect your Pocket PC to your computer.

m Install the Pocket PCinthe cradle.
m  Connect the AC adapter to the power connector of the USB cable.
m  Connect the USB connector of the USB cable to your computer.

Synchronising Setup

A — Pocket PC D — AC Adapter
B — Cradle E — USB Connector
C - USB Cable F — Computer

9. Follow the prompts to complete the synchronisation and establish a
partnership between your Pocket PC and your computer.

Your first synchronisation begins when the ingtdlation is completed. This
takes time, asthe processis copying information to the Pocket PC.
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Press the power button on the Pocket PC and check your Calendar (tap the

Calendar program button or tap & and tap B Calendar). Please note that
your calendar information in Microsoft Outlook on your computer was
copied to your Pocket PC. Also look at Contacts and Tasks. If you have
Contacts and Tasks information on your computer, you should see that

information copied to your Pocket PC.

When done, tap theE button at the top right of the screen to exit the
program.

For further information on using Pocket PC ActiveSync, tap 49 in the

“Today” screen and tape Help in the “Navigation Bar” screen. In the
“Help” screen, tap Connections and tap Set Up Remote Synchronisation
or tap Start and Stop Synchronisation.

For information about using ActiveSync on your computer, start
ActiveSync on your computer and click on ActiveSync Help.

Accessing ActiveSync Help on your computer

43 Microsoft ActiveSync [ [T x]
File  Wiew Tool: | Help

@ a ’7 Microzoft ActiveSync Help
[

Swnc  Shop Microzoft on the Web 4

POCkEt_ Pg About Microzoft ActiveSyne \
13

Connected =

Synchronized

Once you have installed ActiveSync on your computer and performed your
first synchronisation, synchronisation occurs whenever the ActiveSync
components on the Pocket PC and on your computer are activated.

Use the USB cradle for automatic synchronisation. You can aso use
infrared for synchronisation. To set the synchronisation type, tap Tools on
the “ ActiveSync” screen, Connect via IR or Options then USB Sync.
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Using an SD or MMC Card

An optional SD or MMC card can be used to add memory to your Pocket
PC or expand the capahilities of your Pocket PC.

S0MME Card Slot

I E—tn®

-

To use an SD or MMC card, insert it into the SD/MMC dot on the top of
your Pocket PC until it clicks into place. Please refer to the document
supplied with the card for further instructions.

Accessing Pocket PC Functions

Icon

Function

Access

Note You can use an SD 10 card that is compliant with the bsquare
solution.

Access Pocket PC Functions

The following table is a guide to many of the functions and settings for the
Pocket PC. Included in the table is the tapping path for accessing the
function from the Navigation Bar. Please note that not al functions are
listed and some settings and selections may differ from that on your Pocket

PC.
Accessing Pocket PC Functions
Icon Function Access
[H About Pocket Tap Start, Settings, tap the System tab and
] PC tap About to see Pocket PC version and
processor type.

POwvYyEZ D Oollmpn®: @

ActiveSync

Align Screen

Backlight
Settings
Battery Status

Buttons, Front

Calendar

Clock

Contacts

eBackup Utility
eMenu Utility

File Explorer

Find

Help
Inbox

Input Panel

Tap Start, ActiveSync and tap Sync or
Tools.

Tap Start, Settings, tap the System tab
and tap Screen.

Tap Start, Settings, tap the System tab
and tap Backlight.

Tap Start, Settings, tap the System tab
and tap Power.

Tap Start, Settings and Buttons.

Press the Calendar program button on the
front or tap Start and Calendar.

Tap Start, Settings, tap the System tab
and tap Clock.

Press the Contacts program button on the
front or tap Start and Contacts.

Tap Start, Programs and eBackup.
Tap Start, Programs and eMenu.

Tap Start, Programs and File Explorer.

Tap Start and Find.

Tap Start, Help and select a topic.
Tap Start and Inbox.

Tap Start, Settings, Input and select input
method.
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Accessing Pocket PC Functions

Accessing Pocket PC Functions

lcon Function Access
Internet Tap Start, Internet Explorer (requires
Explorer optional modem or Pocket PC synched to

computer).

Memory Tap Start, Settings, tap the System tab
Settings and tap Memory.
MSN Tap Start, Programs and MSN
Messenger Messenger.
Notes Tap Start and Notes.
Owner Tap Start, Settings, Owner Information
information and enter information.
Password Tap Start, Settings and Password.

Connections

Personal

H IO@E@KQEE&Q ®

Pocket Excel

Pocket PC
Basics

Pocket Word

Programs

Regional
Settings

Settings,
Connections

Settings,
Personal

Tap Start, Programs and Pocket Excel.

Tap Start, Help and Pocket PC Basics.

Tap Start, Programs and Pocket Word.

Tap Start, Programs and select a program.

Tap Start, Settings, tap the System tab
and tap Regional Settings.

Tap Start, Settings and tap the
Connections tab. Select Beam or
Connections.

Tap Start, Settings and tap the Personal
tab. Select Buttons, Input, Menus, Owner
Information, Password, Sounds &
Notifications or Today.

lcon Function Access
Syskem Settings, Tap Start, Settings and tap the System tab.
System Select About, Backlight, Certificates, Clock,

II
H

® & @

Sound Volume

Start Menu

Tasks

Windows
Media

Memory, Power, Regional Settings, Remove
Programs or Screen.

Tap Start, Settings, Sounds &
Notifications.

Tap Start, Settings, Menus and select
programs to appear on Start menu.

Tap the Tasks button on the front or tap
Start and Tasks.

Tap Start and Windows Media.
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Get Help

The following table provides a comprehensive list of where you can get
help and information on your Pocket PC, the software, connections,
accessories and support.

Help Resources

Item Resource

Pocket PC Operation Pocket PC Getting Started Guide

Help Resources

Item

Resource

Pocket Word, Excel,
Reader, Outlook (Inbox,
Calendar, Contacts,
Tasks, Notes), Windows
Media Player, Internet
Explorer

Software and Hardware
Resources

Microsoft Pocket PC Features
http://www.pocketpc.com and choose
“Pocket PC” in the menu.

Pocket PC Magazine
http://www.ppcmag.com

Windows Pocket PC

ActiveSync

Pocket PC Reference Guide (this document,
on Companion CD)

Windows Pocket PC Help

Help file included with Windows Pocket PC.
Tap Start in the “Today” screen, tap Help
and tap an item in the “Help Contents”
screen.

Windows Pocket PC web site
http://www.pocketpc.com

ActiveSync Help on your computer

After installing ActiveSync on your computer,
click on Start > All Programs > ActiveSync
to open the ActiveSync window. Select Help
from the menu bar and click on Microsoft
ActiveSync Help.

ActiveSync Help on your Pocket PC

Tap 5 in the “Today” screen and tap Help
on the Navigation Bar. In the “Help
Contents” screen, tap Connections. Select
a topic for help.

ActiveSync Help on the Web
http://www.pocketpc.com and type in
“ActiveSync” in the search box.

Pocket PC Care

Your Pocket PC is a durable, dependable unit built for extensive use and
travel. Follow these guidelines to maintain the condition and performance
of the Pocket PC.

Clean your Pocket PC with a soft, clean, dightly damp, amost dry
cloth. Use only water to dampen the cloth. Do not use any type of
cleaning products or soap or you might damage the touch screen and
discolour the case finish.

Do not spray liquids on the touch screen and case or alow liquids to
drip into the Pocket PC.

Do not put anything on top of the touch screen.

Always use the stylus to prevent scratching the touch screen.

Do not expose your Pocket PC to moisture and temperature extremes.
Avoid dropping or bumping the Pocket PC or the AC adapter.

Do not use the Pocket PC in humid or dusty environments.

Avoid leaving the Pocket PC and its components in direct sunlight or
near heat sources.
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Pop-up Menus

Pop-up menus are used throughout your Pocket PC and vary dightly from
program to program. With pop-up menus, you can quickly choose an
action for an item.

For example, you can use the pop-up menu in the Tasks list to quickly
delete atask or create a copy. To access the pop-up menu, tap and hold the
stylus on the task name that you want to copy or delete. When the pop-up
menu appears, lift the stylus and tap the action you want to perform. To
close the menu without performing an action, tap outside the menu.

Pop-up Menu

“hdé 332 €3

All Tasks ~ Priority

'
+

1 ” Tap here to add a new task |

! Send status reports
Buy bityhday gift
Call Maria

Proof new proposal
c-b-t-l- —-ggage

Tap and hold to display

Create Copy the pop-up menu.
Delete Task Lift the stylus and tap
— the action you want.
Beamn Task...
—— Tap outzide the menu
to close it without performing
an action.
New Tools E|*

Notifications

Y our Pocket PC can remind you of things to do. For example, if you have
set up an appointment in Calendar, a task with a due date in Tasks or an
alarmin Clock, you are notified in any of the following ways.

m A message box appears on the screen.
m A sound is played (you can specify the type of sound).
m A light flashes on the Pocket PC.

To select reminder types and sounds, tap i and Settings. In Settings, tap

Sounds & Notifications. Make your choices and tap o when done. Keep
in mind that what you choose applies throughout your Pocket PC.

Enter Information

Information is entered into your Pocket PC in several ways:

m  Enter typed text in the input panel by using the soft keyboard, Letter
Recognizer, Block Recognizer or Transcriber.

m  Write or draw pictures directly on the screen with the stylus.
m  Speak into your Pocket PC microphone to record a message.

m  Use ActiveSync to synchronise or copy information from your
computer to the Pocket PC.
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Enter Text with the Input Panel

Use the input panel in the Command Bar to select the way you want to
enter information in any program on your Pocket PC. You can either type
using the soft keyboard or write using Letter Recognizer, Block
Recognizer or Transcriber. Whatever you choose, the characters appear as
typed text on the screen.

To show or hide the input panel, tap the Input Panel button. Tap the arrow
next to the Input Panel button to see your options.

Selecting the Input Panel

Options...

Block Recognizer
* Keyboard ]
) Zelect an input method .
Letter Recognizer

Transcriber

MNew Edit ¥iew Tools T, *

Tap to gee your choicesz.

Input Panel t:uuttu:un.|

Using the Soft Keyboard

Use the soft keyboard to enter words as follows. To demonstrate, open
Notes.

1. In Notes, tap the arrow next to the input panel and tap Keyboard at the
Options pop-up.

2. Useyour stylusto tap the keys to enter your information.

When you use the input panel and the soft keyboard, your Pocket PC
anticipates the word you are typing or writing and displays it on the screen.
When you tap the displayed word, it is inserted into the text at the insertion
point. The more you use Pocket PC, the more words it learns to recognise.

Using the Soft Keyboard

Aotz O

Tap here itthis

meeting = i the rigg kit won .
123(1[2(3]4[s|6[7[8[9[0]-[=[«
Tablg|wle[r[t[y[u]ifo[p|[]]
caPla[s[d[f]a[n[ik[1[:]"]
Shlft|Z|H|E|"l"||J|"|m|r| [ /]«
ctlai] " [\ ] [4][t]e]>
Mew Edit Tools (3 # EH

Note To change word suggestion options, such as the number of words

o)

suggested at a time, tap , Settings, tap the Personal tab, tap Input and
tap the Word Completion tab.
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Using Letter Recognizer

With Letter Recognizer, you can use the stylus to write letters, just as you
would on paper. Use these steps to write with Letter Recognizer.

1. Tap the arrow next to the input panel button and tap Letter
Recognizer.

2. Write aletter in the box.

Using Letter Recognizer

Send SLIl:Ij: ol i ¥

Enter upper case characters

\ /Enter lowe case characters
ABC ! ab " 123 +
_______________ — |3

—[Fpe

| | ? I:%
Mew Edit My Text [T=] = =

The written letter is converted to typed text and is displayed on the screen.
For further information on using Letter Recognizer, tap the question mark
next to the writing area.

Using Block Recognizer

With Block Recognizer, you can use the stylus to input character strokes
that are similar to those used on other devices. Use these steps to write
with Block Recognizer.

1. Tap the arrow next to the input panel button and tap Block
Recognizer.

2. Write aletter in the box.
The written letter is converted to typed text and is displayed on the screen.

For further information on using Block Recognizer, tap the question mark
next to the writing area.

Using Transcriber

With Transcriber, you can use the stylus to write anywhere on the screen,
just as you would on paper. Unlike Letter Recognizer and Block
Recognizer, you can write a sentence or additional information. Pause after
writing and let Transcriber change the written characters to typed
characters. Use these steps to write with Transcriber.

1. Tap the arrow next to the input panel button and tap Transcriber.

2. Write anywhere on the screen.

The written words are converted to typed text and displayed on the screen.
For further information on using Transcriber, tap the question mark in the
lower right corner of the screen.
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Using Transcriber Write on the Screen

¢ 17:59 In any program that accepts writing, such as Notes, Calendar, Contacts
and Tasks, you can use your stylus to write directly on the screen. Write
the way you do on paper. You can edit and format what you have written
and convert the information to text at alater time.

Writing on the Screen

Y ou can write directly on the screen in Notes as follows.

1. Open Notes in your Pocket PC.

2. Tap the Pen button to switch to the writing mode. The screen displays
blank space with linesto help you write.

3.  Write your message on the screen (see the following figure).

Note Some programs that accept writing might not have the Pen
[ 3 E ﬁ L ] = | ? | b4 button. See the documentation that may come with some programs to find
out how to switch to the writing mode.

New Edit My Text [=] = <y |~

Editing Your Text
If you want to edit or format typed text, you must first select the text.

1. Highlight the text by dragging the stylus across the text.

2. Tap and hold the selected words and tap an editing command on the
pop-up menu (cut, copy, paste) or tap the command on the Edit menu.
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Writing in Notes

~
.
o
RS

-]
New Edit Tools =1 E|*

Tap the Pen button and use
wour stylus like s pen.

Editing Your Writing
If you want to edit or format your writing, you must first select the writing,
then edit it. Do this as follows.
1. Tap and hold the stylus next to the writing you want to select, until the
insertion point appears.
2.  Without lifting the stylus, drag it across the writing you want to select.

3. Tap and hold the writing, then tap an editing command on the pop-up
menu (cut, copy, paste) or tap the command on the Edit menu.

If you accidentally write on the screen, tap Tools, tap Undo and try again.
You can aso select your writing by tapping the Pen button to deselect it
and then dragging the stylus across the screen.

Converting your Writing to Text

After you hand wrote your message, you can convert it to text. Do it as
follows:

1. If you only want to convert certain words, select them before going to
the next step.

Selecting and Converting Your Writing

.
<
A
B
~
<
PN
B

Cur
Copy
Clear
Recognize || ||
- -
New Edit Tools = | E|* MNew Edit Tools = E:I E|*
Seledt the text you warnt
to convert and tap Recognize on the The writing iz turned into
POp-LIE e, text.
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2. Tap Tools and tap Recognise. Y our writing is converted to text.

You can also tap and hold the selected words until the pop-up screen
displays, then tap Recognise.

If aword is not recognised, it isleft aswriting. If the conversion is not
correct, you can select different words from alist of aternates or return to
the original writing.

1. Tap and hold the incorrect word (one word at atime).

2. At the pop-up menu, tap Alternates. A menu with a list of aternate
words displays.

3. Tapthe word you want to use or tap the writing at the top of the menu
to return to the original writing.

Selecting Alternate Words

T_:}E A/ i

_— HI{
Ef% t PO Tap to retum to your
' original writing.

report!

O, tap the word you want
Repork! touze.

IR — I
Mew Edit Tools |E||é| E|*

Please follow these recommendations.

m  Writeneatly.

m  Write on the lines and draw descenders below the line. Write the cross
of the “t” and apostrophes below the top line so that they are not
confused with the word above. Write periods and commas above the
line.

m  For better recognition, try increasing the zoom level to 300% using the
Tools menu.

m  Write the letters of a word closely and |eave big gaps between words
so that the Pocket PC can easily tell where words begin and end.

m  Hyphenated words, foreign words that use specia characters such as
accents and some punctuation cannot be converted.

m If you add writing to a word to change it (such as changing a“3" to an
“8") after you attempt to recognise the word, the writing you add will
not be included if you attempt to recognise the writing again.

Draw on the Screen

Y ou can draw on the screen in the same way that you write on the screen.
The difference between writing and drawing on the screen is how you
select items and how they are edited. For example, selected drawings can
be resized while writing cannot.

Creating a Drawing

Y ou create a drawing by first creating a box on the screen, then make your
drawing within the box. Do this as follows, using Notes as an example.

1. Cross three ruled lines on your first stroke. A dotted drawing box
appears.

2. Subsequent strokes in or touching the drawing box become part of the
drawing. Drawings that do not cross three ruled lines will be treated as
writing.
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Creating a Drawing

The drawing box indicates

0 — the boundaries of the drawing.

0

1]

Mew Edit Tools [=] E|‘

|F‘er‘| button.

Note You might want to change the zoom level to more easily work on
or view your drawing. Tap Tools and tap a zoom level.

Editing Your Drawing
If you want to edit or format your drawing, you must first select the
drawing, then edit it. Do this as follows:

1. Tap and hold the stylus on the drawing until the selection handle
appears.

To select multiple drawings, deselect the Pen button and then drag to
select the drawings you want.

2. Tap and hold the selected drawing, then tap an editing command on the
pop-up menu (cut, copy, paste) or tap the command on the Edit menu.

3. Resize a drawing by deselecting the Pen button (if selected) and
dragging a selection handle to the size you want.

Record a Message

In any program where you can write or draw on the screen, you can aso
quickly capture thoughts, reminders and phone numbers by recording a
message. In Calendar, Tasks and Contacts, you can include a recording in
the Notes tab.

In Notes, you can either create a stand-alone recording or include a
recording in a written note. If you want to include the recording in a note,
open the note first.

In the Inbox program, you can add arecording to an e-mail message.

Create a recorded message in the Notes program as follows. Recording in
other programsis similar.

1. Hold the Pocket PC microphone near your mouth or other source of
sound.

2. Press and hold the Record button on your Pocket PC until you hear a
beep.

3. While holding down the Record button, make your recording.

4. To stop recording, release the Record button. Two beeps sound. The
new recording appears in the note list or as an embedded icon (see the
following figure). To play a recording, tap it in the list or tap its icon
in the note.

Note You can also make a recording by tapping the Record button on
the Recording toolbar.
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Recording a Message

Quote
from Adam

-

|
o[n|) |[——=]

EE

Mew Edit Tools |;|Zj|é|

E|A

Tap to showear hide

the Recording toolbar.

Indicate s an embedded
recarding.

Tap to kegin recarding.

Use a Preset or Frequently Used Message

When using Inbox or MSN Messenger, use My Text to quickly insert
preset or frequently used messages into the text entry area. To insert a

message, tap My Text and tap a message.

Note You can add text after inserting a My Text message. However,
you have to add it before sending the message.

Using a Preset Message

L'E;-‘?"|M5N Messenger oz 1:58 @

Hi, Can wou meek at 2007

I have another appointment scheduled For 2;00,
bt am availab

Yes.

Mo,

I can't talk right now.
I'll be right there.
I'm running late.

|Last meszags
Where are you?
123(1[2]3]

Hi.
Tab[q[w]¢
EAP| a | s | Goodbye.
Shift] z [ | Call me later.
culai] - [ IlovemyPocketPQl L]
Tools Chats My TE:-I:I:LiI |E A|

=[]

L Taptozelect s
preswitten m essage.

To edit a My Text message, tap Edit in the Tools menu and tap My Text
Messages. Select the message you want to edit and make the desired
changes.
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Find and Organise Information

The Find feature on your Pocket PC helps you to quickly locate
information. Y ou can also organise your information with File Explorer.

Use the following stepsto find information.

1. Onthe &4 menu, tap Find.

2. Enter the text you want to find, select a data type and tap Go to start
the search.

Note To quickly find information that is taking up storage space on your
Pocket PC, tap Larger than 64 KB in Type.

Organise Files

Tap to change folders.

.',F.F File Explorer

o 1204 €9

—=eledt the sort order
for the list.

Use these steps to find files and to organise your information with File
Explorer.

1. Onthe i menu, tap Programs and tap File Explorer.

2. Move files by tapping and holding the item you want to move and
tapping Cut or Copy and Paste on the pop-up menu.

Tap the folder name
to apen it.

Tap and hold to creste
a newy folder.

My Device - Mame
=1 ConnMgr
My Documents
My Flash Disk
1 profiles
31 Program Files
Storage Card view Al Files
Ch Temp
=) Utility PEBIE
= Windows Paste Shortout
Mew Folder
Edit Op...|<[E]] [ & B[«
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Customise Your Pocket PC

You can customise your Pocket PC by adjusting its settings and installing
additional software.

Adjusting Settings

You can adjust Pocket PC settings to suit the way you work. To see
available options, tap &

"ﬁ" Settings and tap the Personal or System tab
located at the bottom of the screen.

Y ou a'so might want to adjust the following.

m  Clock — change the time or set alarms

m  Menus — customise what appears on the 47 menu and enable a pop-

up menu from the New button
m  Owner Information — enter your contact information
m  Password — limit access to your Pocket PC
m  Power — maximise battery life

m  Today — customise the look and the information that is displayed on
the “Today” screen.

Adding or Removing Programs

Programs added to your Pocket PC at the factory are stored in read-only
memory (ROM). You cannot remove this software and you will never
accidentally lose ROM contents. The ROM programs can be updated using
special installation programs with a *.xip extension. All other programs
and data files added to your Pocket PC after factory installation are stored
in random access memory (RAM).

You can install any program created for your Pocket PC, as long as it has
enough memory. The most popular place to find software for your Pocket
PC is on the Pocket PC Web site (http://www.pocketpc.com).

Using ActiveSync to Add Programs

You will need to install the appropriate software for your Pocket PC on
your computer. ActiveSync is already installed on your Pocket PC.

1. Determine your Pocket PC and processor type so that you know which

version of the software to install. Tap 24 and Settings. On the
System tab, tap About. In the Version tab, make a note of the
information in Processor.

2. Insert the CD that contains the program into your computer. You
might see asingle *.xip, *.exe or *.zip file, a Setup.exe file or several
versions of files for different device types and processors. Be sure to
select the program designed for the Pocket PC and your Pocket PC
processor type.

3. Read any installation instructions, Read Me files or documentation
that comes with the program. Many programs provide special
installation instructions.

4. Connect your Pocket PC and computer.
5. Double-click on the *.exefile.

m |f thefileisan installer, the installation wizard begins. Follow the
directions on the screen. Once the software has been installed on
your computer, the installer automatically transfers the software
to your Pocket PC.

m If thefileisnot an installer, you will see an error message stating
that the program is valid but it is designed for a different type of
computer. You will need to move this file to your Pocket PC. If
you cannot find any installation instructions for the program in the
Read Me file or documentation, use ActiveSync Explore to copy
the program file to the Program Files folder on your Pocket PC.
For more information on copying files using ActiveSync, see
ActiveSync Help.

6. Once ingtallation is complete, tap fj Programs and tap the program

icon to switch to it.
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Using the Internet to Add Programs

Use the following procedure to load programs from the Internet on your
Pocket PC.

Note To use the Internet, you need to be connected through an
optional IR modem, SD modem card or SD network card.

Determine your Pocket PC and processor type so that you know which

version of the software to install. Tap 24 and Settings. On the
System tab, tap About. In the Version tab, make a note of the
information in Processor.

Download the program to your Pocket PC straight from the Internet
using Pocket Internet Explorer. You might see asingle * .xip, *.exe or
*.zip file, a Setup.exe file or several versions of files for different
device types and processors. Be sure to select the program designed
for the Pocket PC and your Pocket PC processor type.

Read any installation instructions, Read Me files or documentation
that comes with the program. Many programs provide specia
installation instructions.

Tap the file, such as a *.xip or *.exe file. The installation wizard
begins. Follow the directions on the screen.

Adding a Program to the Start Menu

Use the following procedure to add a program to the Start menu.

2.

Tap [j Settings, Menus, tap the Start Menu tab and tap the check
box for the program. If you do not see the program listed, you can
either use File Explorer on the Pocket PC to move the program to the
Start Menu folder or use ActiveSync on the computer to create a
shortcut to the program and place the shortcut in the Start Menu
folder.

If you are using File Explorer on the Pocket PC:

m Tap H Programs, File Explorer and locate the program (tap the
folder list, labelled My Documents by default and tap My Device
to see alist of al folders on the Pocket PC).

m  Tap and hold the program and tap Cut on the pop-up menu. Open
the Start Menu folder located in the Windows folder, tap and hold
ablank area of the window and tap Paste on the pop-up menu.

m  The program appears on the 2 menu. For more information on
using File Explorer, see “Find and Organise Information,” earlier
in this chapter.

3. If you are using ActiveSync on the computer:

m  Use the Explorer in ActiveSync to explore your Pocket PC files
and locate the program. Right-click on the program and then click
on Create Shortcut.

m  Move the shortcut to the Start Menu folder in the Windows folder.

The shortcut appears on the 4 menu. For more information, see
ActiveSync Help.

Removing a Program

Use the following procedure to remove a program from your Pocket PC.

4 and Settings. On the System tab, tap Remove Programs.

2. If the program does not appear in the list of installed programs, use
File Explorer on your Pocket PC to locate the program, tap and hold
the program and then tap Delete on the pop-up menu.

If the program does not appear in the list of installed programs, use File
Explorer on your Pocket PC to locate the program, tap and hold the
program and then tap Delete on the pop-up menu.
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Use Microsoft Pocket Outlook

m Calendar
m Contacts
m Tasks
m Notes

m Inbox



Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox and Calendar Screen

Notes. You can use these programs individually or together. For example,

e-mail addresses stored in Contacts can be used to address e-mail messages f;; Calendar A 4% 09:50 €3
in Inbox. s

Using ActiveSync, you can synchronise information in Microsoft Outlook
or Microsoft Exchange on your computer with your Pocket PC. You can
also synchronise this information directly with a Microsoft Exchange
Serve. Status Meeting
Each time you synchronise, ActiveSync compares the changes you made 15:00-16:00

on your Pocket PC and computer and updates both computers with the
latest information. For information on using ActiveSync, please refer to
ActiveSync Help on the computer.

Lunch w/ Adam
12:00-13:00 {Corner Cafe) Tap to display or edi
the appaintm ent details.

Y ou can switch to any of these programs by tapping them on the 22 menu.

Calendar: Scheduling Appointments and
Meetings

Use Caendar to schedule appointments, including meetings and other
events. Y ou can check your appointments in one of several views (Agenda, —
Day, Week, Month and Year) and easily switch views by using the View bz Uz E = E|*
menul.

|Tap to creste a new appointment.

2. Tap New. Tap the up arrow and select an input device (keyboard,
letter recognizer).

Note You can customise the Calendar display, such as changing the

first day of the week, by tapping Options on the Tools menu. 3. Seect afield (Subject, etc.). Using the keyboard or letter recognizer,

enter a description and alocation.
4. If needed, tap the date and time to change them.
Creating an Appointment 5. Enter other desired information. Y ou need to hide the keyboard to see

Create an appointment for the Calendar as follows: al availeble fields.

1. If you arein the Day or Week view, tap the desired date and time for
the appointment.
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Calendar Appointment Using the Summary Screen

Tap to return ta the calendar
(the appointtnent is saved
autorm atically).

When you tap an appointment in Calendar, a summary screen is displayed.
To change the appointment, tap Edit.

fw} Calendar 3, ¢ 09:50 (b

Tapto choose from
J7 predefined text. Summary Screen

Subject: T - g
Location: »+—Tapto choose from '{‘j Calendar +e ®Z 09:51 @
presdously entered locations. “rs
Starks: 13,/06,/03 12:00 - Lunch w/ Adam v s
Ends: 13,-"[!6,-“03 1200 ~+—Tapto seled atime.
all Day: Mo Tapto seledt a date. 12:00-13:00 Fri, 13/06,/2003 —— Viewappointment details.
Occurs; Once Corner Cafe
Reminder: Remind me Frennenile poelio: 1 e
15 minuteds)
Cateqories: MO categories...
Appointrent | MNotes I %DTES iza gau:udc_ﬂ pllgg:e
123|1|2|34|5|E|?|B|9|D|- :|* I Maps an IFECTIONS.
Tablg|wle[r[t][y]uli|o]p
CaPlafs[d[ffa[n]ifk[1];]"]
shift| z [ [c[v[b[n[m[,[.[/]+
ctfaia] - [\ ] [V]t]e]=>
Edit |~
Edit Tools ]
6. To add notes, tap the Notes tab. You can enter text, draw or create a | Tap to change
recording. For more information on creating notes, see “Notes: appoirtmert.

Capturing Thoughts and Ideas,” |ater in this chapter. . .
pning d » Creating Meeting Requests

7. When finished, tap OK to return to the calendar. ) )
You can use Calendar to set up meetings with users of Outlook or Pocket

Outlook. The meeting request is created automatically and sent either when
you synchronise Inbox or when you connect to your e-mail server. Indicate
how you want meeting requests sent by tapping Tools and tapping

No?e If you selgct Remind me in an'ap ointment, your Pocket PC Options. If you send and receive e-mail m es through ActiveSync,
reminds you according to the options set in &2, Settings, Personal tab, select ActiveSync.

Sounds & Notifications.
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Schedule a meeting Contacts Screen

Y ou can schedule a meeting as follows: =eled the categary of contacts
you et disslayed inthe list

1. Create an appointment. Fi¥|contacts S ¢ 09:55 €9

2. Inthe appointment details, hide the input panel and tap Attendees. All Contacts - [Find a name ——Tap and enter part of & nam e to

3. Fromthelist of email addresses you have entered in Contacts, select #ab] cde| figh | i [Imn[opa] rst juvw] xyz ekl it m_ fhe =
e s TRl g

Rrawn Tne f2NRY 555-3434 Ul Tap to display or edit
the cortact detail=.

F——Tap and hold to display
& pop-up meny of actions.

The meeting notice is created automatically and placed in the Outbox
folder.

. . . L : Eeam Contact..,
For more information on sending and receiving meeting reguests, see

Calendar Help and Inbox Help on the Pocket PC. DESiE 3t

Contacts: Tracking Friends and Colleagues

Contacts maintains a list of your friends and colleagues so that you can
easily find the information you are looking for, whether you are at home or
on the road. Using your infrared (IR) port, you can quickly share Contacts New View Tools E|‘
information with other device users with IR capabilities. '

|Tap to create a nevw contact.

Creating a Contact

Note To change the way information is displayed in the list, tap Tools Create a contact as follows:
and tap Options.

1. Tap New.

2. Using the input panel keyboard (or other input device), enter a name
and other contact information. Scroll down to see al the available
fields.

3. To assign the contact to a category, scroll to and tap Categories and
select a category from the list. In the contact list, you can display
contacts by category.
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Contacts Input Panel

Tap to retum to the contact
i dhe contact iz saved

Finding a contact

autorn atically). -
.'&;«" Contacks 1-':;.: off 7:38 0y
Mame: B
Tob title: | .
Department: :
Compary:
Work tel: -
Work Fax:
Work addr: v
E-mail: ||
Mobile tel: »1— Scroll to s2e more fields, u
Details | Maokes l Motes iz & good place
123|1|2|3|4|5|E|?|B|9|D|- :l* for maps and directions.
Tablalwle[r[t[y[u]i]o|p
caplafs[d[fla[n[ji[k[I1[;]"
shift[z[x [c[v[b[n[m[.[.[/]+
culaal” [\ ] HEEE
Edit E=]4]

4. To add notes, tap the Notes tab.

You can enter text, draw or create a

recording. For more information on creating notes, see “Notes:

Capturing Thoughts and Ideas,” |

ater in this chapter.

5. When finished, tap [ok] to return to the contact list.

There are four ways to find a contact:

In the contact list, enter a contact name in the box under the navigation
bar. To show al contacts again, clear text from the box or tap the
button to the right of the box.

In the contact list, tap the category list (labelled All Contacts by
default) and select the type of contact that you want displayed. To
show al contacts again, select All Contacts. To view a contact not
assigned to a category, select No Categories.

To view the names of companies your contacts work for, in the contact
list, tap View > By Company. The number of contacts that work for
that company are displayed to the right of the company name.

H Find, enter the contact name, select Contacts for the type and
tap Go.
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Using the Summary Screen

When you tap a contact in the contact list, a summary screen is displayed.

To change the contact information, tap Edit.

Contacts Summary Screen

.',3{.;1 Contacts #4 #< %:07 @

Adam Gabor
Programmer

Fab

Inspired Technologies

—T— Viewwcontact details.

(206) 555-1212 work tel
111 First St, wark addr

Surmmary | Maokes l Tap to viewnotes,

Edit Tools E|A

Tap to change contact information.

Tasks: Keeping a To Do List

Use Tasks to keep track of what you have to do.

Tasks Screen

Select the category of tasks
wou nant displaved inthe lig.

All Tasks - Priority ~-— Select the sort order
afthe list.

]
+

1 ” Tap here to add a new task |

[] ! send status reports
[] Buy bityhday gift

[] callMaria
Ll

Proof new proposal

Indicate s high priority.

_ T-t-A- —--gsage
Create Copy J

Tap to dizplay or edit
the task details.

Delete Task Tap and hold to display
a pop-up meny of actions.
Bearn Task...
New Tools E|*

Tap to create a new task.

Note To change the way information is displayed in the list, tap Tools
and tap Options.
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Creating a task

Create a

1. Tap

task asfollows:

New.

2. Usingtheinput panel keyboard, enter a description.

Tasks Input Panel

Tap to return tothe task
it (the tazk iz zaved
autorn atically).

——Tap to chooze from

predefined subjects.

Maotes iz a good place

Subject:
Priarity: Mormal
Status: Mot Completed
Starts: MNone
Cue: Mone
Qcours: DNce
Reminder:
Cateqories: MO categories...
Task Nntesl
1231|234 |5]6|7[8][0|0]-[=|#
Tabjg|wle|r|t|y[u|i[o|p|[]]
cAPla[s[d[fa[h]i[k[1];]"]
shift| z[x[c[v][b[n[m],[.[/]+
ctlaii| " [ ] [Lt]<]=
Edit EH

for maps and drawings.

3. You can enter a start date and due date or enter other information by
first tapping the field. If the input panel is open, you need to hide it to
see all available fields.

4. To assign the task to a category, tap Categories and select a category
fromthelist. Inthetask list, you can display tasks by category.

5. To add notes, tap the Notes tab. You can enter text, draw or create a
recording. For more information on creating notes, see “Notes:
Capturing Thoughts and Ideas,” later in this chapter.

6. When finished, tap [ to return to the task list.

Note To quickly create a task with only a subject, tap Entry Bar on the
Tools menu. Tap on Tap here to add a new task and enter your task
information.
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Using the Summary Screen

When you tap a task in the task list, a summary screen is displayed. To
change the task, tap Edit.

Tasks Summary Screen

Send status report !
—r—Viewtask details.
Starts: gf18/2003
Due: 5182003 _ -
- Tapto showwand hide additional
Send to the whole team using the new sUmmary infarmation.
format,
— T Viewnotes.
Edit Tools E|A

Tap to change task.

Notes: Capturing Thoughts and Ideas

Quickly capture thoughts, reminders, ideas, drawings and phone numbers
with Notes. You can create a written note or a recording. You can aso
include a recording in a note. If a note is open when you create the
recording, it is included in the note as an icon. If the note list is displayed,
it is created as a stand-alone recording.

Notes Screen

(3 all Folders MName ~—Tapto change the soi
- order ofthe list.
Busmessl 8:54 a 424hb

[._]outlook Notes1 8:54 a 428b
Persunall 8:54 a 424h

e T4 a 432hb
Create Copy

Tapto open a note or
play a recording.

Delete Tap and hold to display
Select all a pop-up menu of actions.

Send via E-mail...
Beam File...

Rename;/Move...

Tapto record.

o5 [——— [« »]®

New Tools =] -
iIE'I-'-I' onls |§| E' Tapto showar hide the

R ecording toolbar.

|Tap to create a new tem.

Creating a Note
Create anote as follows:
1. Tap New.

2. Create your note by writing, drawing, typing and recording. For more
information about using the input panel, writing and drawing on the
screen and creating recordings, see Chapter 2.
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Notes Input Screen

Tap to return ta the note
lizt (the note iz saved

automatically).

Team meeting notes:

=2am,

Julie will get the revernue numbers,

and reports that the product was 3

Adarm will send current status to core

Tanrer is back from the conference

big hit!

123(1[2[3]4[s5]6][7]8]9]0]-[=[«
Tabla|wle[r[t[y|ulio[p[[]]
CAPla|s|d|flalh|j|k[1];]"]
shiftf z[R [c[v[b[n[m[, ].[/]+
culai] - [\ ] [V]t]e]>

New Edit Tools = &~
|

g

]
|Tap to wite on the screen.

Tap to add a recording

tothe note.

Tap to showor hide
the input panel .

Inbox: Sending and Receiving E-mail

You can use the Inbox to send and receive e-mail messages in one of
several ways.

m  Synchronise e-mail messages with Microsoft Exchange or Microsoft
Outlook on your computer.

m  Send and receive e-mail messages by connecting directly to an e-mail
server through an Internet Service Provider (ISP) or a network. You
will need an optional IR modem, SD modem card or SD network card.

Synchronising E-mail Messages

E-mail messages can be synchronised as pat of the genera
synchronisation process. To do this, you need to enable Inbox
synchronisation in ActiveSync. For information on enabling Inbox
synchronisation, please refer to ActiveSync Help on the computer.

During synchronisation:

m  Messages are copied from the mail folders of Exchange or Outlook on
your computer to the ActiveSync folder in Inbox on your Pocket PC.
By default, you receive messages from the past three days only, the
first 100 lines of each message and file attachments of less than 100
KB insize.

m  E-mail messages in the Outbox folder on your Pocket PC are
transferred to Exchange or Outlook and then sent from those
programs.

m  E-mail messagesin subfolders must be selected in ActiveSync on your
computer in order to be transferred.

Note You can also synchronise e-mail messages with your computer
from a remote location. For more information, see Chapter 6.
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Connecting Directly to an E-mail Server

In addition to synchronising e-mail messages with your computer, you can
send and receive e-mail messages by connecting to an e-mail server using
an optional IR modem, SD modem card or SD network card. You will
need to set up a remote connection to a network or an ISP and a connection
to your e-mail server. For more information, see Chapter 6.

When you connect to the e-mail server, new messages are downloaded to
the Pocket PC Inbox folder, messages in the Pocket PC Outbox folder are
sent and messages that have been deleted on the e-mail server are removed
from the Pocket PC Inbox folder.

Messages that you receive directly from an e-mail server are linked to your
e-mail server rather than your computer. When you delete a message on
your Pocket PC, it is also deleted from the e-mail server the next time you
connect based on the settings you selected in ActiveSync.

You can work online or offline. When working online, you read and
respond to messages while connected to the e-mail server. Messages are
sent as soon as you tap Send, which saves space on your Pocket PC.

When working offline, once you have downloaded new message headers
or partial messages, you can disconnect from the e-mail server and then
decide which messages to download completely. The next time you
connect, Inbox downloads the complete messages you have marked for
retrieval and sends the messages you have composed.

Using the Message List

Messages you receive are displayed in the message list. By default, the
most recently received messages are displayed first in the list.

When you receive a message, tap it to open it. Unread messages are
displayed in bold.

Inbox Message List Screen

Seled the service and folder
o snant to display

—Zeledt the zo order
for messages.

——Tap to open a message.

& Robert Brown 8:45PM 16K

RE: Today's Meetino

&y Jay ddams [ [=3h

RE: F'Ieasn_a " Delete |

Andrew Dixo

Status Repo| Move... Tap and hold to display
(& Bradley Bec 1= a popup menu of actions.

RE: Lunch Reply
(& Stuart Munsd  Reply Al

PocketPiC Farvard ||
&) Linda Mitche

Remind
& Mo | Sedieceve  H

RE: Working] Mark as Unread

(= Adam Barr Mark: for Download —
Don't Forget i

Inbox: AckiveSync 11 Ikems,

New Tools Accounts [] E|*

Tap to connect and to
sehd and receive e-mail.

Tap to connect to
the selected zervce.
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Message Screen

e E 217 @ Tap to return to
the message list.

From: Robert Brown

Subject: RE: Today's Meeting
Sent: 4/23/03 5:45:47 &M

Just a rerminder to bring your individual
schedules for the next 2 quarters with
you, we will be discussing projects and
tirmelines,

Thanks,
Bob

| Tap to delete this message.

Edit = & @ 9 |-

Tap to view the presvous
or next message.

Tap to replyto or
forward thizs message.

When you connect to your e-mail server or synchronise with your
computer, by default, you will receive messages from the last three days
only, the first 100 lines of each new message and file attachments of less
than 100 KB in size. The original messages remain on the e-mail server or
your computer.

You can mark the messages that you want to retrieve in full during your
next synchronisation or e-mail server connection. In the message list, tap
and hold the message you want to retrieve. On the pop-up menu, tap Mark
for Download. The icons in the Inbox message list give you visua
indications of message status.

Y ou specify your downloading preferences when you set up the service or
select your synchronisation options. Y ou can change them at any time.

Change options for Inbox synchronisation using ActiveSync options.
For more information, see ActiveSync Help.

Change options for direct e-mail server connections in Inbox on your
Pocket PC. Tap Tools and tap Options. On the Accounts tab, tap the
account you want to change. Tap and hold the account and tap Delete
to remove an account.

Composing Messages

To compose a message, perform the following:

Tap New.

In the To field, enter an e-maill or SMS address of one or more
recipients, separating them with a semicolon or select a name from the
contact list by tapping the Address Book button. All e-mail addresses
entered in the e-mail fieldsin Contacts appear in the Address Book.

Compose your message. To enter preset or frequently used messages,
tap My Text and select a message.

To specify the language, tap Edit and tap Language.

If want to spell check your message before sending, tap Edit and tap
Spell Check.

Tap Send when you have finished the message. If you are working
offline, the message is moved to the Outbox folder and is sent the next
time you connect.
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Composing Screen

Tap to zend the message.

¢ 219

¥ —Tapto showor hide
the complete header.

Edit My Text [’5] = E|‘

Tap to showe 7 hide the
recarding toolbar.

Tap to displaythe Address Book.

Tap to inzet commaon messages.

Managing E-mail Messages and Folders

By default, messages are displayed in one of five folders for each service
you have created: Inbox, Deleted Items, Drafts, Outbox and Sent Items.
The Deleted Items folder contains messages that were deleted from the
Pocket PC. The behaviour of the Deleted and Sent Items folders depends
on the options you have chosen. In the message list, tap Tools and tap
Options. On the Message tab, select your options.

If you want to organise messages into additional folders, tap Tools, then
tap Manage Folders to create new folders. To move a message to another
folder, tap and hold the message in the message list and tap Move to on the
pop-up menu.

Folder Behaviour with a Direct Connection to an E-mail Server

The behaviour of the folders you create depends on whether you are using
ActiveSync, POP3 or IMAP4.

If you use ActiveSync, e-mail messages in the Inbox folder in Outlook
are automatically synchronised with your Pocket PC. Y ou can select to
synchronise additional folders by designating them for ActiveSync.
The folders you create and the messages you move are mirrored on the
server. For example, if you move two messages from the Inbox folder
to a folder named Family and you have designated Family for
synchronisation, the server creates a copy of the Family folder and
copies the messages into that folder. You can then read the messages
while away from your computer.

If you use POP3 and you move e-mail messages to a folder you
created, the link is broken between the messages on the Pocket PC and
their copies on the mail server. The next time you connect, the mail
server sees that the messages are missing from the device Inbox and
deletes them from the server. This prevents you from having duplicate
copies of amessage, but it also means that you no longer have access
to messages that you move to folders created from anywhere except
the Pocket PC.

If you use IMAP4, the folders you create and the e-mail messages you
move are mirrored on the server. Therefore, messages are available to
you anytime you connect to your mail server, whether it is from your
Pocket PC or computer. This synchronisation of folders occurs
whenever you connect to your mail server, create new folders or
rename/del ete folders when connected.
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Use Companion Programs

m Pocket Word

m Pocket Excel

m MSN Messenger

m  Windows Media Player for Pocket PC
m  Microsoft Reader

m Pictures



The companion programs consist of Microsoft Pocket Word, Microsoft
Pocket Excel, Windows Media™ Player for Pocket PC and Microsoft
Reader.

To switch to a companion program on your device, tap Programs on the
2 menu and tap the program name.

Note All titles described in this chapter are optional and may not be
included on your specific Pocket PC. Your Pocket PC may also contain
optional programs that are not documented in this chapter.

Pocket Word

Pocket Word works with Microsoft Word on your computer to give you
easy access to copies of your documents. Y ou can create new documents
on your Pocket PC or you can copy documents from your computer to your
Pocket PC. Synchronise documents between your computer and your
Pocket PC so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes

and trip reports. To create a new file, tap &4, Programs, Pocket Word and
New. A blank document appears. Or, if you have selected a template for
new documents in the Options dialogue box, that template appears with
appropriate text and formatting aready provided. You can open only one
document at a time. When you open a second document, you will be asked
to save the first. Y ou can save a document you create or edit in a variety of
formats, including Pocket Word Document (.psw), Rich Text Document
(.rtf) and Plain Text Document (.txt), Word 97/2000 Document (.doc) and
Word 97/2000 Template (.dot).

Pocket Word contains a list of the files stored on your Pocket PC. Tap afile
in the list to open it. To delete, make copies of and send files, tap and hold a
fileinthelist. Then, select the appropriate action on the pop-up menu.

You can enter information in Pocket Word in one of four modes (typing,
writing, drawing or recording), which are displayed on the View menu.
Each mode has its own toolbar, which you can show and hide by tapping
the Show/Hide Toolbar button on the command bar.

Pocket Word Folders Screen

Select the type of falder you
want displayed in the list.

f;j Pocket Word

[ Al Folders ~ Name = 7a4 10 change the sort
@Agenda 977 a 420b arder ofthe ligt.
| Doc1 9:22 a 416b
Meeting notes 9:22 a 428hb
= l:-.l-"EEl.tElEDPY 9:23 a 424b Tap to open a document.
Delete
select all Tap and hold an item to see

& pop-up menu of actions .

Send via E-mail...
Beam File...

Rename,/ Move...

Mew Tools El*

Tap to create a newdocument.

Note You can change the zoom magnification by tapping View and
tapping Zoom. Select the percentage you want. Select a higher percentage
to enter text and a lower one to see more of your document.

Note |If you are opening a Word document created on a computer,
select Wrap to Window on the View menu so that you can see the entire
document.

Use Companion Programs 4-2



Typing Mode

Using the input panel (keyboard or other input mode), enter typed text into
the document. For more information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. Y ou can select
text as you do in a Word document, using your stylus instead of the mouse
to drag through the text you want to select. Y ou can search a document to
find text by tapping Edit and tapping Find/Replace.

Pocket Word Document

Tapto return ta the
documert list (changes are
saved automatically).

Tap and hold to ==e &
pop-up menu of actions.

Pocke

T,
(F)

Weeting not

Clear

Format...
Paragraph...

Tap to change
formatting options.

——Tap to format texd.

Writing Mode

In writing mode, use your stylus to write directly on the screen. Ruled lines
are displayed as a guide and the zoom magnification is greater than in
typing mode to allow you to write more easily. For more information on
writing and selecting writing, see Chapter 2.

Pocket Word Writing Screen

.ﬁi“ Pocket Word

e ¢ 1208

Tu/ﬂ ) 7}

/'e‘oaf'f'

ASAP!

[

With Space button seledted,
drag to insert space. An arrow
appears showing the zpace
direction and size.

2 E‘A [l I ————Tap to highlight seleded tex.

New Edit View Tuuis ]

Tap to s=led formatting options,
=uch as pen weight and line color,

_ —
B B I _Spil:heck = |

123(1|2]3]4]|s5]6|7[8[00]- =]«
Tabla|wle[r [t[y[ulio[p[[]]
caPla[s[d[fla[h]j[k[1]:]"

shift[z[x [c[v[b[n[m[,[.[/]+
ctfaia] - [\] [4]1]e]>

Mew Edit ¥iew Tools = |~

the toolbar.

Tap to showear hide

Space hutton.

Pen button.

Note If you cross three ruled lines in a single stylus stroke, the writing
becomes a drawing and can be edited and manipulated as described in the
following section.

Written words are converted to graphics (metafiles) when a Pocket Word
document is converted to a Word document on your computer.
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Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear
as a guide. When you lift your stylus off the screen after the first stroke,
you will see adrawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see
Chapter 2.

Pocket Word Drawing Screen

=2 packet Word

1

Room sex up

Select Shape onthe
pop-up menu to convert
ohjects to proper shapes.

b 4 1210

000

Resize an ohject by dragging
the selection handles.

000

e

7=l 218 &

N

=w Edil Yiew Tnuls E|‘

Tap an atrow to
e e your choices.

Tap to zelect formatting options
such ag line weight, 6l calour, and line colour.

FPen button.

Recording Mode

In the recording mode, you can embed a recording into your document.
Recordings are saved as .wav files. For more information on recording, see
Chapter 2.

For more information on using Pocket Word, tap 44 and 9

Pocket Excel

Pocket Excel works with Microsoft Excel on your computer to give you
easy access to copies of your workbooks. You can create new workbooks
on your Pocket PC or you can copy workbooks from your computer to
your Pocket PC. Synchronise workbooks between your computer and your
Pocket PC so that you have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and

mileage logs. To create a new file, tap @, Programs, Pocket Excel and
New. A blank workbook appears. Or, if you have selected a template for
new workbooks in the Options dialogue box, that template appears with
appropriate text and formatting already provided. You can open only one
workbook at a time. When you open a second workbook, you are asked to
save the first. You can save a workbook you create or edit in a variety of
formats, including Pocket Excel Workbook (.pxl), Pocket Excel 1.0
Workbook (.pxl), Pocket Excel Template (.pxt), Excel 97/2000 Workbook
(xls) and Excel 97/2000 Template (.xIt).

Pocket Excel contains a list of the files stored on your Pocket PC. Tap a
filein the list to open it. To delete, make copies of and send files, tap and
hold afile in the list. Then select the appropriate action from the pop-up
menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting and filtering. To display the toolbar, tap View and tap
Toolbar.
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Pocket Excel Screen

A3 =5UMIa1A2) ——Cell cortents appear here
A | B | C | ] az you enter them .

1 | $44.00 ]

2 | &22.00 =

3 £66.00]

4

A ——Format button.

T ] O Ao Sum button,
Feady Sheetl = |Sum=%66.00 W

Fp E = = = $ 1 .00 & 1+—Zoom button,
123/1[2[3]4][5]6][7[8]9]0]-[=]
Tab|g|wle|r[t][y|u]i]o]p
CaPla[s[d[f[a[h[j[k[I;]"

Shift|z [x [c[v[b[n[m[,]. /]

Ctijain] " [\ ] NEEE

Mew Edit Yiew Format Tools | T, El*

Note If your workbook contains sensitive information, you can protect it
with a password. To do so, open the workbook, tap Edit and tap
Password. Every time you open the workbook, you need to enter the
password, so choose one that is easy for you to remember but hard for
others to guess.

Tips for Working in Pocket Excel

Note the following when working in large worksheets in Pocket Excel.

View in full-screen mode to see as much of your worksheet as
possible. Tap View and tap Full Screen. To exit full-screen mode, tap
Restore.

For more information on using Pocket Excel, tap £

Show and hide window elements. Tap View and then tap the elements
you want to show or hide.

Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View and tap Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep row and
column labels visible as you scroll through a sheet.

Split panes to view different areas of a large worksheet. Tap View and
tap Split. Then drag the split bar to where you want it. To remove the
split, tap View and tap Remove Split.

Show and hide rows and columns. To hide a hidden row or column,
select a cell in the row or column you want to hide. Then tap Format,
tap Row or Column and tap Hide. To show a hidden row or column,
tap Tools, tap Go To and then type a reference that is in the hidden
row or column. When done, tap Format, tap Row or Column and tap
Unhide.

1 and @,
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MSN Messenger

MSN" Messenger on your Pocket PC is an instant messaging program that
lets you

m  seewhoisonline
m  send and receive instant messages

m  have instant message conversations with groups of contacts.

To use MSN Messenger, you must have an Internet connection and a
Microsoft Passport™ account or a Microsoft Exchange e-mail account.
You must have a Passport to use MSN Messenger Service. If you have a
Hotmail” or MSN account, you aready have a Passport. Once you have
obtained either a Microsoft Passport or a Microsoft Exchange account, you
can set up your account.

"'&F Programs and MSN Messenger.

To switch to MSN Messenger, tap

Note Sign up for a Microsoft Passport account at www.passport.com.
Get a free Microsoft Hotmail e-mail address at www.hotmail.com.

i

Tap j Programs and Pocket MSN to connect to Pocket MSN web site
where you can subscribe to get popular MSN services on your Pocket PC.

Setting Up

Before you can connect, you must enter Passport or Exchange account
information. Set up an account and sign in as follows:
1. Inthe Tools menu, tap Options.

2. In the Accounts tab, enter your Passport or Exchange account
information.

3. Tosignin, tap the sign-in screen and enter your e-mail address and
password.

Note |If you already use MSN Messenger on your computer, your
contacts show up on your Pocket PC without being added again.

Working with Contacts

The MSN Messenger window shows all of your messenger contacts at a
glance and are divided into Online and Not Online categories. From this
view, while connected, you can chat, send e-mail, block the contact from
chatting with you or delete contacts from your list using the pop-up menu.

MSN Messenger Contacts Screen

.'{1}1 MSMN Messenger o< 5:09 9
_.i. Kim Akers {Online)

_.i. Online

‘i Adarn Barr

Jo
-i ——Tap a contact to start a chat.
Ei. Fandall {ouwway)

‘1 Mot Online
‘1 Richard Bready
‘1 David Hodgson

Send Mail (Tim@woodgrovebank.c...
Block ———Tap and hald ta dizplay
Delete Contack & pop-up menu of actions.
Properties

Tools E|*
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Note To see others online without being seen, in the Tools menu, tap Note To switch back to the main window without closing a chat, tap

My Status and select Appear Offline. Contacts. To revert back to your chat window, tap Chats and select the
person whom you were chatting with.

If you block a contact, it appears offline but remains on the blocked

contact’s list. To unblock a contact, tap and hold the contact, then tap

Unblock on the pop-up menu. To know if the contact you are chatting with is responding, look for the

message under the text entry area.

Chatting with Contacts
MSN Messenger Response Screen

Tap a contact name to open a chat window. Enter your message in the text
entry area at the bottom of the screen or tap My Text to enter a preset f‘j MSN Messenger % 1:57 @
message and tap Send. To invite another contact to a multi-user chat, in -
the Tools menu, tap Invite and tap the contact you want to invite.

—+—iew full chat.
MSN Messenger Chat Screen Hi. Can you meet at 2:007
.'&;«" MSN Messenger =< 1:56 @
_f.ﬂ.dam is typing a message, ——“iewv2atus of the chat.
123(1]2[3[4]|5[6]|7[8[9]|0]-[=|4
' N Gapla s [alT[8 AL TRITIZ1"]
I 3 ] (]
Hi. Can you meek at 2:007 | CAP a |s|d|f|g|h|]j[k]|]]|¢
Bl T o to send message. shift[z [ c[v]b[n[m],[.[/] «
Ctijai]” [\ | [t ]e]>
23[1]2[3[4[5]6]7[8|9]0]-|=|* Tools Chats METEHt‘i |~
Tabja[wle|r|t[y[uli|o[pn]l

caPla[s[d[f[a]n]i[k[1];]"
shitt| z [x[c[v[b[n]m][.[.[/]«
ctfaia] - [\] [L]r]e]~

Tools Chats My Text _.i. B~

-~
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Windows Media Player for Pocket PC

Use Microsoft Windows Media Player for Pocket PC to play digital audio
and video files that are stored on your Pocket PC or on a network. To

& and Windows

switch to Windows Media Player for Pocket PC, tap

Media.

Windows Media Player Screen

Winduws Media & % 4:48 9

(@] (70 Windows Media - 64 kbps B

(DO OB @ —=o=

— Indicates the progress
ofthe current track .

— Tapto adjugt volume.

Platlist Tools E|‘

Ta
to R Tapto skipto

gop. the next song.

Tapto play
Taptoplay |a previous song.
oF pELEE.

Use Microsoft Windows Media Player on your computer to copy digital
audio and video files to your Pocket PC. You can play Windows Media
and MP3 files on your Pocket PC.

For more information about using Windows Media Player, tap &4

Microsoft Reader

Use Microsoft Reader to read eBooks on your Pocket PC. Download books
to your computer from your favourite eBook Web site. Use ActiveSync to
copy the book files to your activated Pocket PC. The books appear in the
Reader Library, where you can tap them in the list to open them.

Note Before you can use Microsoft Reader, you must activate it from
the Microsoft activation site (http://das.microsoft.com/activate). Follow the
instructions provided on the Microsoft Web site.

Each book consists of a cover page, an optiona table of contents and the
pages of the book. Y ou can:

m  Page through the book by using the scroll dial on your Pocket PC or
by tapping the page number on each page.

m  Annotate the book with highlighting, bookmarks, notes and drawings.

m  Search for text and look up definitions for words.

The Guidebook contains al the information you need to use the software.
To open the Guidebook, tap Help on the Reader command bar. Or, on a
book page, tap and hold on the book title and then tap Help on the pop-up
menul.

To switch to Microsoft Reader, tap H Programs and Microsoft Reader.
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Getting Books on Your Pocket PC

You can download book files from the Web. Just visit your favourite
eBook retailer and follow the instructions to download the book files.

Using the Library

The Library is your Reader home page. The home page displaysalist of all
books stored on your Pocket PC or storage card.

To open theLibrary:
m  onthe Reader command bar, tap Library

m  onabook page, tap the book title and tap Library on the pop-up menu.

To open abook, tap itstitlein the Library list.

Microsoft Reader Library Screen

Tap to select
a =ort arder.

Tapto =pe

the books vou

Tap to scroll through
the Library i

Library

The Best American Short Stories
The Ghost Writer

Sort

5 honar
The Hundred Secret Senses  ——— 1 &p to open & hook.

Cutlander

cify

watt to display
irn the izt Suger Plum Dead
Another World
Winter of the Welf Moon
The Last Precinct
shop On Writing
Tap here to kel Passage to Junsau
mﬁ:rvégaﬂz E:% Help OF Love and Cther Demons
the Reader. Return Stranger in a Strange Land
Reading a Book

Each book consists of a cover page, an optional table of contents and the
pages of the book. Navigation options are listed in the bottom portion of
the cover page.

The first time you open a book, you will probably want to go to the first
page or to the table of contents, if there is one. Subsequently, whenever
you open the book, you automatically go to the last page read.
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In addition to the text, each book page includes a page number and book

title.

Y ou can aso page through abook by using the scroll dia on your Pocket PC.

Microsoft Reader Book Page

L~ The Call of the Wild

Search for Text. Find text in a book by tapping Find on the pop-up
menu. Enter the word you want to search for and tap the desired Find
option. Reader highlights found text on the page. To close Find, tap
outside the box. To return to your original page, tap the title and then
tap Return on the pop-up menu.

Copy Text. You can copy text from books that support this feature
into any program that accepts text. On a book page, select the text you
want to copy. Then, tap Copy Text on the pop-up menu. The text can

. be pasted into the program of your choice.
T;ﬁ;&;:{?uﬁn were booming the find, thousands Bookmarks. When you add a bookmark to a book, a colour-coded
optian. of men rushing nto The | bookmark icon appears in the right margin. You can add multiple

Morthland. Thy Add Bookmark

dogs, and the R
Add Highlight
were heavy d Add Note

muscles by whig _
coats to prote| Add Drawing

frost. Find...
E-uI:k “"\."Elj Cﬂp? Text

the sun-kissed Sama ara vaney.
Judge Miller's place, it was called.

Dragto select text and
then tap an option.

bookmarks to a book. Then, from anywhere in the book, tap the
bookmark icon to go to the bookmarked page.

Highlights. When you highlight text, it appears with a coloured
background.

Notes. When you attach a note to text, you enter the text in a note pad
that appears on top of the book page. A Note icon displays in the left
margin. To show or hide the note, tap the icon.

Drawings. When you add a drawing, a Drawing icon appears in the

It stood back from the road, half
hidden among the trees, through
which glimpses could be caught
of the wide cool veranda that ran m  Toseealist of abook’s annotations, including bookmarks, highlights,
text notes and drawings, tap Annotations Index on the book’s cover
page. You can tap an entry in the list to go to the annotated page.

bottom-left corner of the page and drawing tools appear across the
bottom of the page. Draw by dragging your stylus.

45k Tap armwzto turn
the page, of tap and
hald page # 1o bring
Lp page tiffle.

Removing a Book

Using Reader Features
9 d When you finish reading a book, you can delete it to conserve space on

your Pocket PC. If a copy of the book is stored on your computer, you can
download it again at any time.

Reading a book electronically gives you several options not available with
paper books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on
the pop-up menu, as described here.

To remove a book from your Pocket PC, tap and hold the title in the
Library list and then tap Delete on the pop-up menu.
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Pictures

Use Picturesto view .jpg pictures stored on your Pocket PC or on a storage
card, send pictures to others, view a slideshow of your pictures, or set a
picture as the background on the “Today” screen.

To switch to Pictures, tap

Picture Screen

lirwf Pictures

My Pictures -

4 % 00:35 €9

bird coffeeshop
¥
i? (B
i
rauzeurn plaza
r_w m
purnpkin oo

Tools T |

Copying Pictures to Your Pocket PC

2 Programs and Pictures.

Tap to view a picture.

You can copy the picture files from your computer to the My Pictures
folder, within the My Documents folder on your Pocket PC.

For more information on copying files from your computer to your Pocket
PC, see ActiveSync Help on your computer.

Viewing Pictures

Y ou can view thumbnails of .jpg pictures and select a picture that you want
to seein full-screen view.

By default, Picture will display .jpg pictures in the My Pictures folder,
within the My Documents folder on your Pocket PC. If you want to view
pictures stored on a storage card, tap [!] To view pictures stored in your

My Pictures folder, tap L=! .

To open apicture, tap the thumbnail of the picture.

Viewing Pictures

5 4% 09:36 (D

.i‘_r.wf Pictures

Tools Edit 4% & | E|‘
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Viewing Slideshow of Pictures

You can view your .jpg pictures as a dideshow on your Pocket PC.
Pictures will display dlides of the pictures shown in thumbnail view with 5-
second intervals between dlides.

In Pictures, tap & to view pictures as a slideshow.

Tap anywhere on the screen to display the Slideshow toolbar, which you
can use to pause the slideshow, rotate the view, move forward or backward
and stop the slideshow.

Press the right or left button to move forward or backward through the
dlides.

|00 00|

Note You can customize slideshow by tapping Tools, Options and
Slideshow tab in Pictures.

Editing Pictures

After you open a picture, you can rotate, crop, zoom, and adjust the
brightness and color contrast of the picture.

m Tap 2 45 rotate a picture 90 degrees counter-clockwise.

m Tap H 1o crop apicture by dragging and selecting the crop area. Tap
outside of the box to stop cropping.

m  Tap .+ todisplay the Zoom panel, from which you can zoomin or out
of apicture, or return a picture to full-screen size.

m  Tap Edit and tap Brightness and Contrast to adjust the brightness
and contrast levels of apicture.

m  Tap Tools and tap Save Picture As to save the picture asanew file.

Note Tap Edit and tap Undo to undo an edit.

Sending Pictures

Y ou can send a.jpg picture to others using e-mail or infrared.

1. InPictures, tap the picture you want to send as an e-mail attachment or
viainfrared.

2. TapTools and tap Send via Email to create an e-mail message with
the picture attached or tap Beam Picture to send the picture to
another device using the IR communication port.

Note The picture is resized to approximately 30 KB, making it easier to
send over wireless connections.
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Setting Picture as Background

You can use one of your own .jpg pictures as the background on the
“Today” screen, and specify how you want it displayed on the screen, such
as adjusting the transparency level.

1. InPictures, tap the picture you want to set as the background.
2. TapTools and tap Set as Today Wallpaper.
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Use Pocket Internet Explorer

m Pocket Internet Explorer
m Mobile Favourites Folder

m AvantGo Channels



Use Microsoft Pocket Internet Explorer to view Web or Wireless Y ou will see the page that was downloaded the last time you synchronised

Application Protocol (WAP) pagesin either of these ways. with your computer. If the page is not on your Pocket PC, the favourite is
. I . ) dimmed. Y ou need to synchronise with your computer again to download
m  During synchronisation with your computer, download your favourite the page to your Pocket PC or connect to the Internet to view the page.

links and mobile favourites that are stored in the Mobile Favourites

subfolder in Internet Explorer on the computer.

) _ Viewing Favourites
m  Connect to an Internet Service Provider (ISP) or network and browse

the Web directly from your Pocket PC. To do this, you will need an e : e @

optional IR modem, SD modem card or SD network card. You will {75 |Internet Explorer  +3 4£ 451

first need to create the connection, as described in Chapter 6. Favorites
When connected to an ISP or network, you can also download files and 3',17 Mobile Favarites
programs from the Internet or intranet. ; ﬁ; AyvantiEo Channels _

— Tap the favorite you
. s ﬁ Wt o i,
To switch to Pocket Internet Explorer, tap 224 and &= Internet Explorer.
~{¥) Pocket PC.com
Pocket Internet Explorer ) e Ean
You can use Pocket Internet Explorer to browse mobile favourites and
channels that have been downloaded to your Pocket PC without connecting
to the Internet. You can also connect to the Internet through an ISP or a
network connection and browse the Web.
. . . [
0 add [ Delet Tap to add or delete
View Mobile Favourites and Channels pen f Delete 7 Al o Ttz i,
Y ou can easily view mobile favourites and channels with your Pocket PC. E|A
1. Tapthe Favourites icon to display your list of favourites.
Browse the Internet
ITap 10 open your Favourites Y ou can browse the Internet with your Pocket PC. Here's how.
view Tools & € 0} <% E|*
1. Set up a connection to your ISP or corporate network using

2. Tap the page you want to view. Connections, as described in Chapter 6.

2. To connect and start browsing, do one of the following:
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m  Tap the Favourites icon and then tap the favourite you want to MO b lle Favo urites Folde r

view.
Only items stored in the Mobile Favourites subfolder in the Favourites
folder in Internet Explorer on your computer are synchronised with your
Pocket PC. This folder was created automatically when you installed

m  Tap View and tap Address Bar. In the address bar at the top of
the screen, enter the Web address you want to visit and then tap
Go. Tap the arrow to choose from previously entered addresses.

ActiveSync.
Using the address bar Favourite Links
5} Internet Explorer &t (€ 00:03 €3 During synchronisation, the list of favourite links in the Mobile Favourites
|—|ﬁle: { Mowindowes\ default it | @ folder on your computer is synchronised with Pocket Internet Explorer on
= your Pocket PC. Both computers are updated with changes made to either
i Microsoft' list each time you synchronise. Unless you mark the favourite link as a
Pocket Internet Explorer mobile favourite, only the link is downloaded to your Pocket PC and you

need to connect to your ISP or network to view the content. For more

Wielcome to Pocket Internet information on synchronisation, see ActiveSync Help on the computer.

Explorer, Mot online yet? Find out

by to get_connected and save Mobile Favourites
offline content.

If you are using Microsoft Internet Explorer 5.0 or later on your computer,

Carrier you can download mobile favourites to your Pocket PC. Synchronising
mobile favourites downloads Web content to your device so that you can
N E‘ view pages while you are disconnected from your | SP and compulter.
Use the Internet Explorer plug-in installed with ActiveSync to create
PocketPC.com mobile favourites quickly.
Creating a Mobile Favourite
View Tools & & &} <% E|* 9

Create amobile favourite as follows:

1. In Internet Explorer on your computer, click on Tools and click on
Create Mobile Favourite.

Note To add a favourite link while using the Pocket PC, go to the page
you want to add, tap and hold on the page and tap Add to Favourites. 2. To change the link name, enter anew name in the Name box.

3. Optionally, in Update, select adesired update schedule.

4. Click on OK. Internet Explorer downloads the latest version of the
page to your computer.
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5. If you want to download the pages that are linked to the mobile
favourite you just created, in Internet Explorer on the computer, right-
click on the mobile favourite and click on Properties. In the
Download tab, specify the number of links deep you want to
download. To conserve memory, go only one level deep.

6. Synchronise your Pocket PC and computer. Mobile favourites that are
stored in the Mobile Favourites folder in Internet Explorer are
downloaded to your Pocket PC.

Note If you did not specify an update schedule in step 3, you need to
manually download content to keep the information updated on your
computer and Pocket PC. Before synchronising with your Pocket PC, in
Internet Explorer on your computer, click on Tools and click on
Synchronise. You will see the last time content was downloaded to the
computer and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile
favourites. In Internet Explorer on your computer, click on View, click on
Toolbars and click on Customise.

Saving Pocket PC Memory

Mobile favourites take up storage memory on your Pocket PC. To
mi nimise the amount of memory used:

m  Use ActiveSync settings to turn off pictures and sounds for the Mobile
Favorites information type or to stop some mobile favorites from
being downloaded to your Pocket PC. For more information, see
ActiveSync Help.

m  Limit the number of downloaded linked pages. In Internet Explorer on
the computer, right-click on the mobile favourite you want to change
and click on Properties. In the Download tab, specify 0 or 1 for the
number of linked pages you want to download.

AvantGo Channels

AvantGo is a free interactive service that gives you access to personalised
content and thousands of popular Web sites. You subscribe to AvantGo
channels directly from your Pocket PC. Then, you synchronise your Pocket
PC and computer or connect to the Internet to download the content. For
more information, visit the AvantGo Web site (http://avantgo.com).

Sign up for AvantGo

Sign up for the free AvantGo service as follows:
1. In the ActiveSync options on the computer, turn on synchronisation
for the AvantGo information type.

2. In Pocket Internet Explorer on your Pocket PC, tap the Favourites
button to display your list of favourites.

3. Tapthe AvantGo Channels link.
4. Tapthe Activate button.

5. Follow the directions on the screen. Y ou will need to synchronise your
Pocket PC with your computer and then tap the My Channels button
to complete the AvantGo Setup.

When synchronisation is complete, tap the AvantGo Channels link in your
list of favourites to see a few of the most popular channels. To add or
remove channels, tap the Add or Remove link.
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Get Connected

m Transfer Items Using Infrared

m Connect to the Internet

m Connect to Work

m End a Connection

m Connect Directly to an E-mail Server

m Get Help on Connecting



You can use your Pocket PC to exchange information with other maobile
devices in addition to your computer, a network or the Internet. The
following connection options are available:

m  Usethe IR port on your Pocket PC to send and receive files between
two devices. If this is the method you want to use, see the following
section “Transfer Items Using Infrared.”

Note Check with your Internet Service Provider (ISP) to see if the ISP
supports receiving e-mail on your Pocket PC.

m  Connect to your ISP. Once connected, you can send and receive e-mail
messages by using Inbox and view Web or WAP pages by using
Microsoft Pocket Internet Explorer. The communication software for
creating an ISP connection is aready installed on your Pocket PC.
Your service provider should provide software needed to install other
services, such as paging and fax services. If this is the method you
want to use, see “Connect to the Internet” later in this chapter.

m  Connect to the network at your company or organisation where you
work. Once connected, you can send and receive e-mail messages by
using Inbox, view Web or WAP pages by using Pocket Internet
Explorer and synchronise with your computer. If this is the method
you want to use, see “Connect to Work” later in this chapter.

m  Connect to your computer to synchronise remotely. Once connected, you
can synchronise information such as your Pocket Outlook information. If
this is the method you want to use, please see ActiveSync Help on your
computer or Connections Help on the Pocket PC.

Transfer Items Using Infrared

With the Pocket PC, you can send and receive data to and from another
similarly equipped device using the IR communication port. In addition, you
can use the IR port to synchronise data with your computer, in place of using
the synchronising cable. Using infrared (IR), you can send and receive
information, such as contacts and appointments, between two devices.

Send Information

Send information as follows:

1. Switch to the program where you created the item you want to send
and locate the item in the list.

2. Position the Pocket PC and the second device so that the IR ports face
each other. Position the devices within 5 to 50 centimetres apart. You
might want to remove the Pocket PC cover so that it does not block the
IR port (see Chapter 1).

Beaming files

l.%.}" File Explorer &4 4< 10:05 9

My Documents Mame -
[C1 Business -
[ Personal B
= Templates

Dog! na/naing 410K

Cut
Copy

Rename
Delete

Send via E-mail...

veamn File, .

Edit Op...|« ][0 & |-

Note If the units are too far apart or if something blocks the path
between the two ports, data might not be sent or received correctly.
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3. Be sure that nothing obstructs the path between the IR ports on both
devices and that the ports are aligned properly.

4. Tap and hold the item and tap Beam File on the pop-up menu.

Note You can also send items, but not folders, from File Explorer. Tap
and hold the item you want to send and then tap Beam File on the pop-up
menu.

Receive Information
Receive information as follows:
1. Alignthe IR portson the two devices so that they are unobstructed and
within 5 to 50 centimetres apart.
2. Havethe owner of the other device send the information to you.

3. By default, your Pocket PC monitors all incoming beams. A message
will pop up on the screen asking if you want to receive. Tap Yes.

Note If you want to disable the automatic monitoring of incoming

beams, tap , Settings, tap the Connections tab and Beam. Uncheck
the Receive all incoming beams item.

Connect to the ISP

Y ou can connect to your ISP and use the connection to send and receive e-
mail messages and view Web or WAP pages.

Create a Modem Connection to Your ISP

Create a modem connection to your | SP as follows:

o o > ©

Obtain the following information from your | SP: dial-up access telephone
number, user name, password, domain name and TCP/IP settings.

If your Pocket PC does not have a modem, install an optional IR
modem or SD modem card.

Tap 4 and Settings. In the Connections tab, tap Connections.
In My ISP, tap Add a new modem connection.
Follow the instructionsin the New Connection Wizard.

To view additional information for any screen in the wizard or while
changing settings, tap @.

To start the connection, use one of the following programs. Y our Pocket
PC automatically begins connecting. Once connected, you can:

Send and receive e-mail messages by using Inbox. Before you can use
Inbox, you need to provide the information it needs to communicate
with the e-mail server. For specific instructions, see “Connect Directly
to an E-mail Server,” later in this chapter.

Visit Internet Web or WAP pages by using Pocket Internet Explorer.
For more information, see Chapter 5.

Send and receive instant messages with MSN Messenger. For more
information, see “MSN Messenger” in Chapter 4.
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Connect to Work

If you have access to a private network, such as a corporate network you
use at work, you can send e-mail messages, view intranet pages,
synchronise your Pocket PC and possibly access the Internet. You can
connect to work in one of two ways:

Create a modem connection by using a Remote Access Services
(RAS) account. Before you can create this modem connection, your
network administrator needs to set up a RAS account for you. If thisis
the method you want to use, see “Create a Modem Connection to a
Network.” Your network administrator might also give you Virtual
Private Network (VPN) settings.

Use an optional SD network card and a net tap to connect to the
network. If thisisthe method you want to use, see “Create an Ethernet
Connection to a Network.”

Use an optional SD wireless network card to connect to the network
wirelesdly. If thisisthe method you want to use, see “Create a
Wireless Connection to a Network.”

Create a Modem Connection to a Network

Create your modem connection to a network as follows:

Obtain the following information from your 1SP: dial-up access telephone
number, user name, password, domain name and TCP/IP settings

Install an optional IR modem or SD modem card.

Tap &4 and Settings. In the Connections tab, tap Connections.
In My Work Network, tap Add a new modem connection.
Follow the instructionsin the New Connection Wizard.

To view additional information for any screen in the wizard or while
changing settings, tap @.

To start the connection, use one of the following programs. Your Pocket
PC automatically begins connecting. Once connected, you can:

Send and receive e-mail messages by using Inbox. Before you can use
Inbox, you need to provide the information it needs to communicate
with the e-mail server. For specific instructions, see “Connect Directly
to an E-mail Server,” later in this chapter.

Visit Internet or intranet Web or WAP pages by using Pocket Internet
Explorer. For more information, see Chapter 5.

Send and receive instant messages with MSN Messenger. For more
information, see “MSN Messenger” in Chapter 4.

Synchronise. For more information, please refer to ActiveSync Help
on the computer.

Create an Ethernet Connection to a Network

Create an Ethernet connection to a network as follows:

Y ou do not need to create a new connection on your Pocket PC. Y ou
need an optional SD network card for your Pocket PC.

Get a user name, password and domain name from your network
administrator.

Ingtall the Ethernet card on your Pocket PC. For instructions on ingalling
and using the Ethernet card, see the owner’s manud for the card.

The first time you install the card, Network Settings appears
automatically so that you can configure the Ethernet card. Most
networks use DHCP, so you should not have to change these settings
unless your network administrator instructs you to do so. Tap OK. (If
it does not appear or to change settings later, tap &4 and Settings. Tap
Connections tab, Advanced tab and Network Card.

If you need to enter specific server information, tap the appropriate
adapter, and then tap Properties. Most networks use DHCP, so you
should not have to change these settings unless your network
administrator instructs you to do so.
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6. If necessary, connect the network card to the network by using a
network cable. For information, see the documentation that came with
your network card.

To start the connection, use one of the programs listed in the preceding
section. Once connected, you can perform the same activities as listed in
the preceding section.

Create a Wireless Connection to a Network

A wireless network can be added either when the network is detected, or
manually by entering settings information.

1. Ingall thewireless network card on your Pocket PC. For ingtructionson
ingtalling and using the wireless network card, see the owner’s manual for
the card.

2. To manudly enter information, tap 2d and Settings. Tap
Connections, Connections tab, Network Card and Wireless tab.
Then, tap Add new. If the network was detected, step two is not
necessary.

3. Inthe General tab, enter a network name. If the network was detected,
the network name is automatically entered and cannot be changed.

4. From Connects to, select what your network connects to, Work or the
Internet.

5. To connect to an ad-hoc connection, select This is a device-to-
computer (ad-hoc) connection.

To start the connection, use one of the programs listed in the preceding
section. Once connected, you can perform the same activities as listed in
the preceding section.

End a Connection

To end a connection, do one of the following:

m  When connected viadia-up or VPN, tap the Connection icon on the
navigation bar and tap Disconnect.

m  When connected via cable or cradle, detach your Pocket PC from the
cableor cradle.

m  When connected via I nfrared, move the Pocket PC away from the
computer.

m  When connected via a network (Ethernet) card, remove the card from
your Pocket PC.

m  When connected via a wireless network, switch off the connection.

Connect Directly to an E-mail Server

You can set up a connection to an e-mail server so that you can send and
receive e-mail messages by using Inbox on your Pocket PC. You need an
optional IR modem, SD modem card or SD network card to do this.

Note The ISP or network must use a POP3 or IMAP4 e-mail server and
an SMTP gateway.

Y ou can use multiple e-mail services to receive your messages. For each e-
mail service you intend to use, first set up and name the e-mail service. If
you use the same service to connect to different mailboxes, set up and
name each mailbox connection.
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Set up an E-mail Service

In Inbox on your Pocket PC, tap Accounts and tap New Account. Follow
the directions in the New Service wizard.

If you require help on using E-mail Setup, tap 9 When finished, tap
Accounts and Connect to connect to your e-mail server. For more
infformation on using the Inbox program, see “Inbox: Sending and
Receiving E-mail Messages” in Chapter 3.

Setting up a new E-mail

¢ W 10:08

E-miail Setup {1/5) o

E-mail address

Enter -mail address:

|Eam:e| || Back || Mext |
123/1[2[3]4|5]6[7[8[0[0]- =]«
Tab[a[w[e[r[t]¥[uli]o]p
capla[s[d[f[a[n[i[k[I[; ]

shift|z [ [c[v[b[n[m|.|.[/] &
ctfai] - [\] [L]r]e]=
Edit E|*

Get Help on Connecting

More information on the procedures described here, as well as information
on additional procedures, can be found in the following locations.

m  “Inbox: Sending and Receiving E-mail Messages’ in Chapter 3.

= Online Help on the Pocket PC. Tap Bl and @ Help. Tap View, Al
Installed Help and Inbox or Connections.

m  ActiveSync Help on the computer. In ActiveSync, click Microsoft
ActiveSync Help on the Help menu.

Accessing ActiveSync Help on your computer

+3) Microsoft ActiveSync
File ‘iew Tools | Help

@ e |7 Microzoft ActiveSync Help
|

Sync Siop Microzoft on the Web k

Pocket_P(  About Microsolt ActiveSyne \
1+

Connected =

Synchranized

m  For troubleshooting information, see the Pocket PC Web site at:
http://www.pocketpc.com
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If You Have Problems

Problem Solving
Soft Reset
Hard Reset

Help Resources



Y ou may occasionally encounter a problem with your Pocket PC. In most
cases, the problem is one that you can solve yourself.

If there is a problem, the Pocket PC may display an error message. If this
happens, follow any instructions on the screen.

If screen messages do not help or an error message does not appear, refer
to the information in this chapter to help determine and solve the problem.

Problem Solving

When trying to solve problems, you should note what the Pocket PC was
doing when the problem occurred and what you attempted to do to correct
the problem. Thisinformation is useful if you request assistance.

See the following table to match your problem area and view what to do.

Problem Solving

Problem Solving

Problem

What to Do

Unit stops
responding or locks

up

Soft reset the Pocket PC (see “Soft
Reset” later in this chapter).

Recharge the battery (see Chapter 1).

Hard reset to factory settings (see “Hard
Reset” later in this chapter).

CAUTION, all your data is lost when you perform a hard reset.

Problem What to Do

No display 1. Press the power button.
Recharge the battery (see Chapter 1).

3. Check the backlight and brightness
settings. Tap [, Settings, tap the
System tab and Backlight.

4. Soft reset the Pocket PC (see “Soft
Reset” later in this chapter).

Battery power is low
or does not last long

Recharge the battery (see Chapter 1).

Use external power as much as possible.

Shorten the auto-suspend time. Tap B
Settings, tap the System tab, Power
and the Advanced tab.

Adjust the backlight and brightness
settings to a lower value. Tap [,
Settings, tap the System tab and
Backlight.

Turn off sounds not needed. Tap 4],
Settings and Sound and Notifications.

Display is dark or 1. Press any button to turn on the backlight.

hard to read . . .
2. Adjust the bkllght and brightness
setting. Tap F&d, Settings, tap the
System tab and Backlight.

3. Use the Zoom tool or Text Size tool to
enlarge text.

Unit responds slowly 1. Recharge the battery (see Chapter 1).

or erraticall
y 2. Soft reset the Pocket PC (see “Soft
Reset” later in this chapter).

Storage or program
memory is low or
unavailable

Close all unnecessary programs and
tasks.

Move data to a storage card.
Set programs to save to a storage card.

Remove programs you no longer use
(see “Removing a Program” in Chapter
2).

Adjust the slider in memory settings
allocation. Tap 4, Settings, tap the
System tab, Memory.

Soft reset the Pocket PC (see “Soft
Reset” later in this chapter).
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Problem Solving

Problem

What to Do

Touch screen does
not respond

Calibrate the touch screen. Tap H
Settings, tap the System tab, Screen
and Align Screen.

AC Adapter does not
work

Check that all connections are secure.
Check that the AC outlet is working.

Problem Solving

Problem

What to Do

Data is lost after the
battery runs
completely out of
power

Whenever possible, keep your Pocket
PC connected to the AC adapter and a
power source. This keeps the battery

charged. If the battery runs completely

Connection to the
computer does not
work

Check that all connections and cables
are secure and correct for the task being
performed.

Check that the USB connection is
enabled in ActiveSync on your computer.
If the USB connection is already enabled,
disable the USB connection, close the
Connection Settings window and then
reopen and re-enable the USB
connection.

Reset your Pocket PC before connecting
the USB cable (see “Soft Reset” later in
this chapter). Always disconnect your
Pocket PC before you restart your
computer.

Connection to the
computer is lost after
being idle for some
time

The USB port of your computer could be
under the influence of power
management. You can disable the power
management for the USB Root Hub
through Windows XP’s control panel (see
Windows XP online help).

NOTE, If the computer goes into hibernation or standby mode, the
ActiveSync connection will be severed. This is regular behaviour.

Unit does not switch
off when pressing
the power button

To switch your Pocket PC off, just quickly
press the power button. When the power
button is pressed longer, only the
backlight is switched off, leaving your
Pocket PC in a low power state.

out of power and the AC adapter is not
connected in time, you lose your data.

2. To prevent data loss, regularly backup
your data to your computer using
ActiveSync (see ActiveSync online help
on your computer) or to a storage card
using eBackup utility (see eBackup
online help).

Soft Reset

Occasionally, you may need to reset your Pocket PC; for example, you
should reset:

m  After you restore data from your computer.

m  When your Pocket PC stops responding; in other words, it appearsto
be “frozen” or “locked up.”

A soft reset is similar to restarting your computer. It restarts the operating

system, but you will lose any unsaved data.

1. Remove the SD/MMC card (if installed).

2. If possible, save your data.

3. Unscrew the cap of your stylus. Use the pointed end of the cap to press
and hold in the reset button for several seconds.
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E 1. Backup your dataif necessary.
i 2. Disconnect al cables from your Pocket PC.
E : 3. Make surethat your Pocket PC is switched off.
4

. Unscrew the cap of your stylus. Use the pointed end of the cap to slide
IE the hard reset switch to the OFF (up) position.

Hard Reset

In some cases, you may need to clear the memory (RAM) from your
Pocket PC with a hard reset. For example, you should clear the memory:

m  When your Pocket PC does not respond after a soft reset.

= Whenyou forget your password. 5. Wait for 1 minute and then slide the switch back to the ON position.

Clearing the memory means all data you have entered in RAM, including 6. Your Pocket PC automatically turns on.

all files, system settings and additional programs you have installed, will 7 Taoth h he calibrati I
be erased. Y ou Pocket PC will restore to the factory default state. - Tap the touch screen to start the calibration and activation.

A CAUTION Save your data to a memory card or to your

computer before doing a hard reset. All your data is lost when you do a
hard reset.
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Help Resources

If the problem you are experiencing cannot be solved, you might want to
try the following help resources.

Help Resources

Item

Resource

Windows Pocket PC

ActiveSync

Pocket Word, Excel,
Reader, Outlook (Inbox,
Calendar, Contacts,
Tasks, Notes), Windows
Media Player, Internet
Explorer

Windows Pocket PC Help

Help file included with Windows Pocket PC. Tap Start on
the “Today” screen, tap Help on the “Programs” screen and
tap an item on the “Help Contents” screen.

Windows Pocket PC web site
http://www.pocketpc.com

ActiveSync Help on your computer

After installing ActiveSync on your computer, click on Start
> All Programs > ActiveSync to open the ActiveSync
window. Select Help from the menu bar and click on
Microsoft ActiveSync Help.

ActiveSync Help on your Pocket PC

Tap B at the “Today” screen and tap Help on the
Navigation Bar. At the “Help Contents” screen, tap
Connections. At the “Connections Help” screen, tap a help
topic.

ActiveSync Help on the Web
http://www.pocketpc.com and type in “ActiveSync” in the
search box.

Microsoft Pocket PC Features
http://www.pocketpc.com and choose “Pocket PC” in the
menu.

If You Have Problems 7-5



Specifications

m System
m Physical

m Environment



The following specifications are standard except where noted.

System Specifications

Display

65K colour, 240 x 320 pixels, TFT, liquid crystal display (LCD), with front
light, touch screen

CPU
Intel XScale PXA255, 300-MHz processor

User Data Entry Methods

Touch screen (input via stylus)
Scroll (Jog) dial

Soft keyboard

Block recognizer

L etter recognizer

Transcriber

Read Only Memory (ROM)
64 megabytes (MB)

Synchronous Dynamic Random Access Memory (SDRAM)

64 megabytes (MB) (User accessible SDRAM is 35.53MB.)

Speaker

One built-in speaker

Infrared (IrDA) Communication

Datatransfer rate: up to 115.2 kb per second

Distance: 5 to 20 centimetres

Pocket PC 1/0 Ports

IrDA port
Headset jack
Power port (DC in)

USB Cradle

USB PC connect cable attached
Power port (DC in) on cable

Card Slots

One Secure Digital (SD)/MultiMediaCard (MMC) card slot, supporting SD
IO card that is compliant with bsguare solution

Front lighting

Automatic mode

Power

AC Adapter

— Input Voltage: 100 to 240 volts AC, 50 or 60 Hz

— Output Voltage: 5.0 volts, 1.0 amp

Battery: One rechargeable Lithium-lon (Li-lon) 900 mAh battery

(included)
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Power Management
m  Low battery power detection
— Lessthan 50 % (battery low warning)
— Lessthan 10 % (battery very low warning)

— 0% (unit shut down)

Data Protection

m  Battery depleted, unit shut down until battery is charged, datain RAM
can be retained for 72 hours

Accessories (shipped with Pocket PC)

m  AC adapter with European and UK converters

m  USB Cradle

Physical Specifications
Dimensions (approximate)
m 4.82in. (h) x3.02in. (w) x 0.44 in. (d)
m 122.5mm (h) x 76.8 mm (w) x 11.3 mm (d)

Weight (approximate)
m  4.16 oz. (with battery)
m 118 grams (with battery)

Environment Specifications
Operating Environment
m  Temperature: 32° to 104°F (0° to 40°C)
m  Humidity: 20% to 90% (Non condensing)

Storage Environment
m  Temperature: 14° to 140°F (—10° to 60°C)
m  Humidity: 20% to 90% (Non condensing)
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Index

A
AC adapter
connecting, 1-8
specifications, 8-2
Accessories, 8-3
ActiveSync, 5-4
add programs, 2-11
features, 1-12
Activites
partid listing, 1-12
Adjusting settings, 2-11
AdvantGo
channels, 5-4
signup, 5-4

B
Basics
entering information, 2-2
input panel, 2-3
Navigation Bar, 1-11
notifications, 2-2
pop-up menus, 2-2
screens, 1-9
Today screen, 1-10
Battery
charging, 1-7
charging LED, 1-3, 1-8
Lithiumlon, 1-2
specifications, 8-3
warning messages, 1-8
Beaming files, 6-2
Block recognizer, 2-4
Buttons
navigation, 1-3
power, 1-5

program, 1-3
recording, 1-5
reset, 1-5

C
Calendar
creating an appointment, 3-2
creating meeting requests, 3-3
schedule a meeting, 3-4
summary screen, 3-3
Cadlibration, 1-9
Card dots, 1-2, 1-5
Care, 1-17
Cleaning, 1-17
Command bar, 1-10
Connection
direct to e-mail server, 6-5
end, 6-5
getting help, 6-6
tothe ISP, 6-3
to work, 6-4
Connectors
Cradle power, 1-6, 1-7
cradle to Pocket PC, 1-6
Pocket PC power, 1-6
Pocket PC to cradle, 1-6
USB, 1-6
Contacts
checking, 1-11
creating, 3-4
finding, 3-5
summary screen, 3-6

tracking friends and colleagues, 3-4

Cradle, 8-2
connecting to power, 1-7

features, 1-2, 1-6
Customization

adding or removing programs, 2-11

adjusting settings, 2-11

D

Drawing
editing on screen, 2-8
on screen, 2-7

E
Editing text, 2-5
E-mail
sending and receiving, 3-9
E-mail service
setting up, 6-6
Ethernet
connecting to network, 6-4

F

Features
back, 1-4
bottom, 1-6
cradle, 1-6, 1-7
external, 1-2
front, 1-3
general, 1-2
left side, 1-5
right side, 1-4
top, 1-5

Front lighting, 8-2

Functions
accessing, 1-15
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G
Getting help
resources, 1-17

H
Hard reset
location, 1-4
setting to OFF, 7-4
setting to ON, 1-7
Headset jack
location, 1-4
Help
contents, 1-12
resources, 1-17, 7-5

|
I/O ports, 8-2
Inbox
composing messages, 3-11
connecting to e-mail server, 3-10
managing messages and folders, 3-12
sending and receiving e-mail, 3-9
synchronizing e-mail, 3-9
using message list, 3-10
Information
entering, 2-2
finding, 2-10
organizing, 2-10
Input panel
entering text, 2-3
using block recognizer, 2-4
using letter recognizer, 2-4
using soft keyboard, 2-3
using transcriber, 2-4
Internet
add programs, 2-12
connecting via modem, 6-3
Internet Explorer

creating mobile favorite, 5-3
favoritelinks, 5-3
mobile favorites folder, 5-3
mobile links, 5-3
saving memory, 5-4

IR port, 8-2
location, 1-5
receiving information, 6-3
transferring items, 6-2

ISP
connecting to ISP via modem, 6-3

K
Keyboard
soft, 2-3

L
LED
battery charging, 1-3
notification, 1-3
Letter recognizer, 2-4

M
Memory, 1-2
RAM, 8-2
ROM, 8-2
Message
frequently used, 2-9
preset, 2-9
sound recording, 2-8
Microphone
location, 1-3
Microsoft Reader
book removal, 4-10
downloading books, 4-9
features, 4-10
library, 4-9
reading books, 4-9

Modem
connecting to Internet, 6-3
connecting to network, 6-4
MSN Messenger
chatting with contacts, 4-7
setting up, 4-6
working with contacts, 4-6
MultiMemoryCard, 8-2
card dlot location, 1-5
using, 1-16

N
Navigation Bar screen, 1-12
Navigation buttons, 1-3
Network
connecting via ethernet, 6-4
connecting via modem, 6-4
Notes
capturing thoughts and ideas, 3-8
creating, 3-8
Notification LED, 1-3
Notifications, 2-2

(0]
Operating system, 1-2

P
Pictures
copying pictures, 4-11
editing pictures, 4-12
features, 4-11
sending pictures, 4-12
setting picture as background, 4-13
slideshow, 4-12
viewing pictures, 4-11
Pocket Excel
features, 4-4
tipsfor using, 4-5
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Pocket Internet Explorer
browsing, 5-2
features, 5-2
view favorites, 5-2
Pocket MSN, 4-6
Pocket PC 2003
operating system, 1-2
Pocket Word
drawing mode, 4-4
features, 4-2
recording mode, 4-4
typing mode, 4-3
writing mode, 4-3
Pop-up menus, 2-2
Power
connector on Pocket PC, 1-6
connector on USB cable, 1-6
Power button, 1-5
Power management, 8-3
Problems
solutions, 7-2
solving, 7-2
Processor, 1-2, 8-2
Program buttons, 1-3
Programs
ActiveSync, 1-12
adding to Start menu, 2-12
adding with ActiveSync, 2-11
adding with Internet, 2-12
Calendar, 1-12
Contacts, 1-12
Inbox, 1-12
Internet Explorer, 1-12
list, 1-12
Notes, 1-12

Outlook, 1-12

removing from Start menu, 2-12
Settings, 1-12

Tasks, 1-12

Windows Media, 1-12

R
Recording
message, 2-8
Recording button
location, 1-5
Reset button, 1-5
Resources
help, 7-5

S

Screen
drawing on, 2-7
editing writing, 2-6
writing on, 2-5

Screens

Navigation Bar, 1-9, 1-11

Today, 1-9, 1-10
Scroll dial
location, 1-5
Secure Digita
card dot location, 1-5
Secure Digital card, 8-2
using, 1-15
Soft reset, 7-3
Speaker, 1-3, 8-2
Specifications
card dots, 8-2
CPU, 8-2
cradle, 8-2
display, 8-2
environment, 8-3
front lighting, 8-2
1/0 ports, 8-2
infrared (IR) port, 8-2
memory, 8-2

operating environment, 8-3

physical, 8-3

speaker, 8-2

storage environment, 8-3
system, 8-2

weight, 8-3

Start menu

adding programs, 2-12
removing programs, 2-12

Stylus

T

location on Pocket PC, 1-5
use of, 1-9
using, 1-2

Tasks

creating, 3-7
summary screen, 3-8
todolist, 3-6

Technical support, 7-5
Text editing, 2-5
Today screen, 1-10
Touch screen, 1-3
Transcriber, 2-4
Troubleshooting

U

problem solving, 7-2
solutions, 7-2

Unpacking, 1-2
USB connector on cradle, 1-6

w
Windows Media Player

features, 4-8

Wireless Network, 6-5
Writing
converting to text, 2-6
editing on screen, 2-6



on screen, 2-5
tips, 2-7
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